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	Тема, которая стала лейтмотивом данной серии статей, необъемлема и неисчерпаема, однако надо когда-то останавливаться. Так почему бы это не сделать сейчас? Полгода для серии достаточно. Поэтому я заканчиваю непрерывную череду статей, которых уже около тридцати. Данная статья будет последней в этом цикле. Но это вовсе не значит окончание ее вообще и мой уход из раздела "Работаем с графикой". Мы просто будем раскрывать новые, не менее, а может и более интересные темы, как связанные, так и не связанные с PhotoShop. На ближайшее время в мои планы входит рассказать про Corel Photo-Paint 10, также очень интересный по своим возможностям графический редактор, рассказать про новую программу создания Flash-анимаций Corel Rave и кое-что еще. Одним словом, окончание этой, судя по количеству писем читателей, популярной серии, вовсе не значит снижение интереса "Работаем с графикой".
Если у вас есть вопросы или пожелания, то пишите мне на e-mail, и я отвечу вам лично, или иногда будут появляться отдельные статьи, продолжающие серию с ответами на наиболее распространенные вопросы, а также с новыми эффектами.

Кроме статей по PhotoShop, которые время от времени будут появляться в "Компьютерной газете", некоторые его возможности будут рассматриваться и в "Издательских системах". Кстати, если вам графика нравится как вид деятельности, то очень советую покупать кроме КГ еще и эту газету. Стоит она совсем дешево, а по насыщенности полезной информацией заслуживает самые лестные отзывы.

Если вы читали практически все статьи из данной серии, то имеете уже достаточный багаж знаний для того, чтобы придумывать свои эффекты, изобретать свои трюки. Если удастся создать что-либо интересное, то пишите и рассказывайте о своих изобретениях.

Закончить данную серию я решила с того же, с чего и начинала, а именно с работы с текстом. Много раз уже писалось о том, насколько полезно и интересно создавать замысловатые надписи и что многие из описанных на примере шрифтов эффектов можно применять не только к тексту, но и практически к любым другим объектам.

Каменные буквы

Для создания данного изображения откройте файл (File->New (Файл->Новый), либо сочетание клавиш Ctrl+N) произвольных размеров. Цветовая модель создаваемого рисунка не имеет значения, однако для того, чтобы реализовать описываемый эффект в цвете, рекомендую RGB, CMYK или Lab. Если вам достаточно получить аналогичный черно-белый результат, то предпочтение может быть отдано такому режиму, как Grayscale. 
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Выберите цвет или иллюстрацию для фона, на котором будет располагаться текст. (Я взяла за основу черный цвет второго плана, для достижения большей контрастности). Напишите любой текст. Буквы шрифта, которые вы будете использовать для создания основной надписи, должны быть довольно массивными и иметь четко выраженную форму. Классическим примером такого шрифта является Times New Roman (Bold).

Следующие действия будут относиться только к тексту и не должны затрагивать все остальное изображение.

Переведите вашу надпись в растровый режим. Для этого щелкните правой клавишею мыши по слою, на котором расположен текст (если вы работаете с PhotoShop 6.0), и по букве "Т" в этом же слое (при работе с версией 5.5). Перед вами появится раскрывающееся меню, в котором необходимо выбрать Rasterize Layer (Рендеринг слоя), как уже говорилось ранее, с этого момента текст становится совокупностью цветных точек (пикселей), а следовательно, утрачиваются все свойства текста, а также возможности редактирования.

Выделите буквы при помощи инструмента "Magic Wand" ("Волшебная палочка"). Данная операция не требует никакой особой сноровки, так как текст - это единственный объект, расположенный на данном слое.

Не снимая выделение, объедините все существующие слои. Для этого вы можете воспользоваться сочетанием клавиш Ctrl+E, либо Layer->Merge Down (Слой->Слияние вниз).

Начните преобразование вашего текста с фильтра "Океанская дрожь". Диалоговое окно данной опции появится после действий: Filter->Distort->Ocean Ripple (Фильтр->Искажение->Океанская дрожь).

Не стоит указывать слишком большие величины в настройках, так как необходимо лишь немного исказить края, чтобы они приняли неправильную форму. Я рекомендую значение обоих параметров установить в интервале от 3 до 7.

Воспользуйтесь фильтром "Кристаллизация". Filter->Pixelate->Crystallize (Фильтр->Пикселизация->Кристаллизация). Здесь он необходим для того, чтобы несколько сгладить полученный эффект рваных краев. Величина параметра настройки может варьироваться от 4 до 7.

После применения данных фильтров, края вашей будущей каменной надписи оказались полностью сформированы. Примерно они должны выглядеть так, как на итоговом рисунке.

Так как с границами текста мы определились, то осталось имитировать текстуру. Предлагаю начать с создания шероховатой поверхности. Для этого можно воспользоваться фильтром "Шум". Выполнение данного действия состоит из следующих пунктов: Filter->Noise->Add Noise (Фильтр->Шум->Добавить шум).

Обратите внимание на то, чтобы ваши буквы по-прежнему оставались выделенными, так как иначе шум будет накладываться не только на текст, но и на фон, что внесет неясность в ваше изображение. Силу установите примерно равную 20-30. Обязательно поставьте флажок возле параметра Monochromatic (Монохроматичный), что обеспечит возникновение пикселей другого тона цвета букв, а не цветов, принадлежащих всей цветовой палитре программы.

Последним шагом станет окончательное формирование структуры текста. Для того чтобы имитировать фактуру различных материалов, создан целый раздел фильтров, называющийся Texture (Текстуры). Советую выбрать один из фильтров, находящихся в этом разделе, хотя вы можете предпочесть ему другой. Предлагаю проделать следующее: Filter->Texture->Craquelure (Фильтр->Текстуры->Кракелюры).

Думаем, что описывать все настройки данного фильтра не имеет смысла, поэтому остановимся на рекомендациях значений: Crack Spacing - 20-25, Crack Depth - 3-7, Crack Brightness - 3-7.

После применения "Кракелюр" поверхность вашего текста приобретет зернистую, неправильной формы текстуру.

Если вы работаете с большим размером букв, то все настройки фильтра следует увеличить на 3-5 пунктов. Это необходимо для того, чтобы неравномерности, появившиеся на поверхности изображения, были больших размеров.

Вот, в принципе, и все. Данный эффект впечатляет своей простотой и хорошим результатам. Для создания подобной надписи особых навыков работы не требуется, поэтому этот способ доступен даже тем, кто только начинает осваивать PhotoShop.

Еще один интересный эффект, о котором хочется рассказать, - как имитировать текст из ртути.

Надпись из ртути
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В предыдущих статьях вы уже познакомились с тем, как можно создавать текст, фактура которого имитирует металл. Имеются в виду железные буквы и золотой текст, однако этим возможности PhotoShop не исчерпываются. Сейчас будет приведен универсальный способ создания металлических поверхностей, который по моей прихоти превратится в ртуть, а по вашей - может в серебро, золото или платину.

Создайте новое изображение произвольных размеров и цветовой модели (за исключением Grayscale, если вы не намерены ограничиться черно-белым изображением).

Работа будет начинаться с дополнительных каналов, то есть само изображение не будет претерпевать никаких изменений, а будет создаваться выделение, которое впоследствии необходимо для создания рисунка.

Создайте новый канал. Для этого откройте палитру каналов и щелкните левой клавишей мыши по иконке с изображением белого листка (Create a New Channel) либо по черному треугольнику вверху палитры каналов, из раскрывшегося меню выберите New Channel (Новый канал).

Обратив внимание на то, чтобы только что созданный канал был активным, напишите белым цветом необходимый текст.

Снимите выделение (сочетание клавиш Ctrl+D), которое всегда появляется при написании текста в дополнительном канале. Это происходит потому, что альфа-каналы это области выделения, которые при создании текста сразу преобразуются.

Смягчите края шрифта при помощи фильтра Gaussian Blur (Размытие по гауссу) из раздела Blur (Размытие). Радиус воздействия данного фильтра зависит от размера шрифта. На приведенном вашему вниманию примере он был равен 3.3.

После того, как вы применили данный фильтр, необходимо создать еще один дополнительный канал, скопировав на него предыдущий. Для этого перетащите уже существующий канал на иконку с изображением чистого листа.

Сделав активным новый канал, сместите на нем изображение. Для этого проделайте следующее: Filter->Other->Offset (Фильтр->Другие->Смещение). Рекомендую передвинуть изображение на 1 пиксель по горизонтали и по вертикали.

Перейдите на предыдущий канал и примените к нему тот же фильтр, однако величину смещения поставьте теперь -1; -1. 
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Сейчас объедините два ваших канала в один при помощи вычислений. Данная опция вызывается при помощи команд Image->Calculations (Изображение->Вычисления). В данном случае вычисления будут происходить между двумя каналами Copy и Copy 2. Выделение, находящееся во втором канале, будет отниматься от выделения в первом, а результат запишется в новый дополнительный канал. Что касается слоев и инвертирования, то данные опции не применяются.

Так как белый цвет символизирует выделенные области, черный - невыделенные, а серый соответственно - частично выделенные, то после предыдущего преобразования почти все изображение оказалась замаскированным. Это значит, что после того, как вы загрузите данный канал в выделение, оно будет защищено от воздействия. Для того чтобы это исправить, инвертируйте данный канал при помощи сочетания клавиш Ctrl+I, либо Image->Adjust->Invert (Изображение->Настройки->Инвертировать). После этого ваше изображение примет полностью противоположный вид тому, какое было.

Сейчас начинается одна из самых сложных частей работы, а именно ручное редактирование. Для этого вам понадобится такой инструмент, как аэрограф. Обратите внимание на его нажим. Он должен быть небольшим, так как вам будет необходимо лишь легкое воздействие на изображение. Я рекомендую установить его порядка 5-8%. А теперь при помощи кисти средних размеров с мягкими краями нанесите пару мазков на ваше изображение.

СОВЕТ

Не старайтесь полностью повторять итоговое изображение, так как в этом нет смысла. Оно приведено лишь для того, чтобы вам было легче ориентироваться при выборе размера, цвета либо каких-нибудь других настроек, используемых при создании изображения.

Пока данное изображение не очень напоминает металлический текст, однако, после следующего шага он должен стать именно таковым. Я предлагаю применить "Кривые". Так как данный инструмент позволяет изменять одни цвета, не трогая при этом другие, то он идеально подходит для того, чтобы увеличивать контрастность там, где это необходимо, не трогая другие участки. Я применила кривую, изображенную на рисунке, вам следует создать нечто похожее. Однако не следует забывать, что это всего лишь дополнительный канал, который существует вне самого рисунка, поэтому, если вы переключитесь в режим RGB, то увидите, что ваше изображение по-прежнему остается белым чистым листом.

Далее следует довести вашу маску до идеального, готового к применению состояния. Для этого вы можете загрузить одно из созданных ранее выделений, если они подойдут. Все зависит от того, как сильно изменилась ваша надпись за время работы. Можете воспользоваться "волшебной палочкой", выделив буквы, а все остальное закрасив белым цветом. И третий вариант - это взять небольшую мягкую кисть и закрасить ею все, кроме самих букв. Несмотря на то, какой вариант вы выберите, итог будет одинаковый.

И, наконец, загрузите канал в выделение, щелкнув по нем левой клавишею мыши, нажав Ctrl.

Следующий шаг и определит, что же у вас получится, а именно вам необходимо выбрать цвет для заливки изображения. Я выбрала серо-синий. Что у меня получилось, вы можете увидеть на рисунке.

Если вы закрасите текст желтым либо серым, то у вас получится соответственно золотой либо серебряный текст. В итоге вы пришли к универсальной заготовке металлических букв, как и было обещано сначала.

Ответы на наиболее часто задаваемые вопросы читателей КГ.

Как установить дополнительные плагины?

Чтобы установить дополнительные фильтры, описанные в этой серии статей, нужно совсем немного. Запустите плагин как обычную программу, и он попросит вас указать папку Plug-ins PhotoShop. По умолчанию это папка 'Disc'/Adobe/PhotoShop 6.0/Plug-ins. Но не забывайте, что эту папку можно переместить в любое другое место, используя Preferences (Предпочтения) PhotoShop. Я, в частности, так обычно и делаю, дабы потратить меньше времени при установке всяких дополнительных фильтров. В случае, если фильтр не является программой, а просто файл с расширением 8BF, то просто скопируйте его в указанную папку. Да, и не забудьте перегрузить PhotoShop - дополнительные модули сканируются именно при загрузке.

Как писать в программе по-русски?

Честно говоря, мне уже надоело отвечать на этот вопрос. Два раза в течение серии я уже публиковала ответ, но, видимо, круг читателей КГ достаточно широк и многие покупают ее не регулярно, поэтому вопросы все идут и идут. Ну что, раз народ хочет, напечатаем и в третий. Желание читателей для авторов закон :).

Способ первый - терапевтический
1. Запустите редактор реестра (например, в директории Windows запустите Regedit.exe или в основном меню выберите "выполнить" и наберите "regedit");
2. Откройте HKEY_LOCAL_MA-CHINESYSTEMCurrentControlSetControlNlsCodePage;
3. Теперь измените значение 1252:
Для WindowsNT "C_1251.NLS", для Windows 95/98 "cp_1251.nls"
4. И обязательно перезагрузите компьютер. Если вы все сделали правильно, то должно заработать.

Способ второй - хирургический
Дело в том, что шрифты, поставляемые вместе с Windows, сами по природе своей не русские. Поэтому можно купить диск со шрифтами и переустановить в системе их все, используя "Шрифты" из Панели управления.

Как определить кисти (Brushs), фигуры (Shapes), образцы (Pattern)?

Это три отдельных вопроса, загнаных в один ответ. Действительно, многое невозможно сделать, не используя, к примеру, свои кисти.

Для молодых пользователей напомню, что кисть может быть любого вида и размера, а не только представленные в поставке PhotoShop. Аналогично можно сказать и в отношении Shapes и Pattern. А определить их очень просто. Для этого необходимо выделить прямоугольным выделением (в случае кистей и образцов) и нажать Edit->Define pattern (Brushs). Для создания новой фигуры ничего выделять не требуется, а достаточно просто нажать Edit->Define Shape.

Как в PhotoShop 6.0 создавать gif-анимацию?

Непосредственно в Photoshop никакую анимацию создавать нельзя. Но с ним в стандартной поставке идет программа ImageReader, в которой эта возможность неплохо проработана. Освоить ее не составит особого труда. Эти программы постепенно интегрируются и, я думаю, к седьмой версии PhotoShop сольются в одну.

Как создать плавный переход от объекта в фон?

Этот эффект очень простой, поэтому в данной серии описан не был. Просто выделите объект по контуру, а затем запустите Select->Feather (Выделение->Оперить), после чего скопируйте (Ctrl+C) и вставьте на фон (Ctrl+V).

Вот и все. Серию можно считать завершенной. Мне кажется, я могу по праву гордиться ею - больше нигде нет такой большой коллекции нестандартных, неявных приемов работы в PhotoShop. По моим подсчетам, я описала более восьмидесяти различных эффектов. Хочется сказать спасибо Юрию Гурскому за идейную помощь и поддержку, читателям за внимание и письма. А Белтелекому большое не спасибо за ужасную прозвонку на беспарольный Интернет :).
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	После небольшого перерыва было решено вновь возобновить рубрику "Работаем с графикой" и начать ее с небольшой серии статей, которая является продолжением одноименного цикла, опубликованного в прошлом году. Этот выбор был сделан не случайно, а потому, что в последнее время я стала получать достаточно много писем с просьбами продолжить эту тему, а также с интересными примерами, предложенными самими читателями. Учитывая ваши пожелания, в этом и нескольких следующих номерах выйдет продолжение. В него войдут только самые яркие примеры. Вы по-прежнему можете присылать свои вопросы, предложения и пожелания по адресу, указанному в конце статьи.

И сегодня мы вновь затронем тему имитации объема в PhotoShop. Так как это редактор, предназначенный для работы с двумерными растровыми изображениями (хотя последнее время в него интегрируется все больше векторных элементов), а создание реалистичных, пусть и достаточно простых изображений необходимо всегда, то и начнем мы с рассмотрения того, как при помощи стандартных инструментов, фильтров и прочих функций создать реалистичную сигарету.
Такие мелочи актуальны всегда, так как их можно использовать не только как декоративные элементы при создании сайтов, плакатов и реклам, но и как самостоятельные изображения или их фрагменты. Итак, речь пойдет о том, как правдоподобно нарисовать обычную сигарету.

Сигарета
Создание начнем с нового изображения: File->New (Файл->Новый) или сочетание клавиш Ctrl + N. Параметры можно выбрать любые, то есть те, с которыми вам будет удобней работать.
Активизируйте инструмент Rectangular Marquee (Прямоугольное выделение), для чего выберите его в Toolbox (Палитре инструментов) или нажмите клавишу M.
Создайте прямоугольное выделение, которое будет впоследствии фильтром. Оставьте место над или под ним для остальной части сигареты.
Для удобства лучше каждый элемент создавать на своем слое, чтобы при необходимости его можно было бы безболезненно заменить на более подходящий.
Итак, для создания нового слоя можно выполнить следующее: Layer->New->Layer (Слой->Новый->Слой) или воспользоваться клавиатурным эквивалентом, а именно сочетанием клавиш Ctrl + Shift + N. Можно также обратиться к одноименной палитре и щелкнуть там по иконке с изображением чистого листа, расположенной внизу.
Залейте созданное ранее выделение на новом слое оранжевым цветом (таким, как фильтр сигареты), воспользовавшись инструментом Paint Bucket (Заливка) (горячая клавиша — G).
Для имитации неоднородности структуры следует добавить немного шума, выполнив: Filter->Noise->Add noise (Фильтр->Шум->Добавить шум). Силу действия следует установить небольшую, так как он используется для придания правдоподобия. На приведенном примере Amount (Сила) была равна 6. Distribution (Дистрибутив) был выбран Gaussian (Гаусс), параметр Monochromatic (Монохромный) отключен.
В результате выполнения вышеописанных действий должна получиться, пусть пока и плоская, но все же заготовка фильтра.
Для реалистичности следует взять небольшую кисть и нарисовать на фильтре более светлым цветом несколько разбросанных штрихов.
Следующий этап работы будет посвящен созданию основной части сигареты, а именно той, которая содержит табак.
Создайте новое прямоугольное выделение, которое будет располагаться над или под фильтром (в зависимости от оставленного места), и залейте его белым (или лучше немного грязноватым) цветом. Однако перед этим следует создать еще один слой, предназначенный для этой части изображения.
Установите в качестве основных цветов черный и белый, нажав клавишу D, и воспользуйтесь фильтром Filter->Sketch->Note Paper (Фильтр->Набросок->Бумага).
На приведенном примере были использованы следующие настройки: Image Balance (Баланс изображения) — 16, Graininess (Градуированность) — 3, Relief (Рельеф) — 4.
Далее мы будем имитировать объем. Для этого понадобится еще один слой (Ctrl + Shift + N).
Создайте выделение такое, чтобы оно охватывало всю сигарету.
Возьмите инструмент Gradient (Градиент) (горячая клавиша — G), который является главным помощником при имитации объема. Тип установите Reflected (Отраженный), а вид — Foreground to background (от цвета переднего плана к цвету фона). Напомним, что основной цвет должен оставаться белым и черным.
Залейте выделенную область так, чтобы создавался эффект скрученной в трубочку бумаги, то есть по краям она должна быть темнее, а в середине — светлее.
Измените режим наложения слоя с градиентом на Multiply (Умножение), в котором будут видны только темные участки слоя, а также отрегулируйте параметр Opacity (Прозрачность). На приведенном примере он был равен 68%.
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В результате у вас должна получиться достаточно правдоподобная, хотя еще неоконченная сигарета.
Если вы возьмете реальную сигарету и присмотритесь к ней, то заметите, что на границе раздела фильтра и бумаги обычно есть еще небольшая полоска.
Создайте для нее выделение. Измените черный основной цвет на желто-оранжевый и залейте полученную область на новом слое ранее использованным градиентом. Только переход в нем будет осуществляться не от черного к белому и обратно, а от желтого к белому.
И последний этап работы — это создание табака, которое также следует проводить на новом слое.
Выделите прямоугольную область на конце сигареты и заполните ее грязно-коричневым цветом.
Вновь воспользуйтесь фильтром Noise (Шум), только силу действия установите значительно большую (можно даже максимальную), однако необходимо обязательно активизировать параметр Monochromatic (Монохромный).
Возьмите инструмент Erase (Ластик) (клавиша, позволяющая осуществить такой выбор с клавиатуры — E), жесткую кисть и сотрите часть области так, чтобы она получилось рваной и небрежной, то есть похожей на табак.
В конце можно склеить все слои, нажав сочетание клавиш Ctrl + Shift + E или выполнив: Layer->Merge Visible (Слой->Слияние видимых).
В результате должно получиться очень правдоподобное изображение сигареты, такое, как представлено на рисунке.
Следующий эффект, который бы хотелось предложить вашему внимание — это создание снежинки. Он простой, но очень эффектный и заслуживает особого внимания. Это один из показательных вариантов, то есть на нем демонстрируется не только конкретно взятый эффект, но и подход, который можно использовать при решении самых разнообразных задач.

Снежинка
Задача, которую мы себе ставим — вовсе не достигнуть правдоподобия, а даже напротив, — создать декоративный вариант.
Процесс, который здесь воссоздан, знаком практически всем с детства, следовательно, и результат будет похож на тот.
Сначала вкратце опишем процесс создания, прежде чем переходить к непосредственной реализации:
Как уже говорилось, воссоздавать мы будем всем известный способ создания снежинок, а именно тот, когда бралась бумага, складывалась несколько раз так, чтобы получился уголок, а после ножницами вырезались различные узоры. После того, как лист разворачивался, вы могли видеть стилизованную снежинку.
Здесь работа будет вестись по тому же принципу — будет создан уголок, а после многократно скопирован и размещен так, чтобы образовался замкнутый круг.
Для начала вам потребуется создать новый файл: File->New (Файл->Новый) или Ctrl + N.
Затем мысленно или для удобства при помощи сетки (для того, чтобы ее увидеть, следует выполнить: View->Show->Grid (Вид->Показать->Сетку) или нажать сочетание клавиш Ctrl + ") разделите его на четыре равные части, каждую из которых затем еще пополам.
Выделите один из таких участков при помощи инструмента Polygonal Lasso (Краеугольное лассо), активизировать который можно либо в Toolbox (Палитре инструментов), либо нажав клавишу L.
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Создайте новый слой, для чего выполните: Layer->New->Layer (Слой->Новый->Слой) или Ctrl + N. Для этой операции можно также воспользоваться одноименной палитрой, щелкнув там по иконке с изображением чистого листа, расположенной внизу, или из дополнительного меню, выбрав команду New Layer (Новый слой).
Залейте полученную область цветом будущей снежинки.
Активизируйте инструмент Eraser (Ластик), горячая клавиша — Е. А теперь, выбирая различные кисти, вытирайте разнообразные фигуры внутри полученной области.
Старайтесь сделать ее как можно более ажурной, так как в этом случае результат будет интереснее.
Если хотите имитировать работу маленького ребенка, то следует напротив, удалять достаточно крупные и "неловкие области".
Выделите все содержимое слоя с заготовкой снежинки, нажав сочетание клавиш Ctrl + A или выполнив: Select->All (Выделить->Все).
Скопируйте в буфер обмена (Edit->Copy (Редактировать->Копировать) или Ctrl + C), а затем вставьте назад (Edit->Past (Редактировать->Вставить) или Ctrl + V).
Отобразите полученное изображение относительно вертикали. Для этого необходимо выполнить: Edit->Transform->Flip Horizontal (Редактировать->Трансформировать->Отобразить горизонтально).
Сместите полученное изображение так, чтобы оно стало логичным продолжением первого фрагмента.
Склейте два верхних слоя, нажав сочетание клавиш Ctrl + E.
Выделите их содержание и снова скопируйте, а затем вставьте назад.
Поверните полученный фрагмент на 90 градусов в любом направлении (Edit->Transform->Rotate 90 (Редактировать->Трансформировать->Вращать на 90 градусов)).
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Придвиньте этот кусок снежинки так же, как и предыдущий. В результате должна получиться половинка снежинки.
Вновь склейте два верхних слоя и повторите две последние операции вновь, только поворот следует осуществлять на 180 градусов.
В результате должна получиться снежинка, напоминающая ту, которую можно вырезать из бумаги. Она представлена на рисунке.
Если вы хотите создать более тонкую и изящную снежинку, то следует не вырезать из фона фигуры, а наоборот, на прозрачном слое рисовать 1/8 снежинки линиями, различными кистями и фигурами.
После склеить их аналогичным способом.
Если же хотите придать полученной снежинке особое изящество, то можно сделать ее немного объемной, выполнив: Layer->Layer Style->Bevel and Emboss (Слой->Стили слоя->Скосы и рельефы).
Таким способом была получена снежинка, представленная на другом рисунке.
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	Что это такое 

При описании приемов компьютерной графики и работы с редакторами постоянно встречается понятие маски (mask). Поскольку внимания ему обычно уделяется не так уж и много, но как раз от масок большей частью и зависит успех описываемых методов обработки изображений, у новичков часто возникают трудности.

Если тем, кто работает с компьютерной графикой профессионально или достаточно часто, все понятно, то начинающие не всегда могут сразу сообразить, в чем суть предлагаемых им приемов. А так как все больше пользователей берется за создание Web-страничек, где на графике завязано очень многое, обстоятельный разговор о масках давно назрел.

Это я понял из общения с одним знакомым. Он, бедолага, с интересом читал мои предыдущие опусы, посвященные графике, но попытки сделать то же самое оказывались неудачными. И, как я понял, основная проблема в том, что он не умеет эффективно работать с масками.

Что же за чудо такое скрывается за этим термином? По определению, в компьютерной графике маска - это средство, позволяющее защитить от изменений некоторую часть растрового изображения. Нечто вроде трафарета. Маска состоит из открытых и закрытых для редактирования участков. В окне редактора при рисовании она представляется в виде бегущей черно-белой штриховой линии (marquee), очерчивающей эти участки. То есть компьютерный трафарет прозрачен, вы видите и то, что не попадает в его прорези.

В графических редакторах применяется и более наглядное представление маски - в основном при ее создании или изменении. В этом случае маска показывается в виде черно-белого изображения, соответствующего трафарету, вырезанному из черной бумаги. Белые участки на маске - прорези в трафарете, через которые можно добраться до обрабатываемой картинки.

При всем сходстве компьютерная маска имеет одно принципиальное отличие от того трафарета, которым привыкли пользоваться художники-оформители. Она может быть полупрозрачной. Под полупрозрачностью маски понимается то, что она пропускает изменения (воздействие инструментами рисования и фильтрами) к картинке в ослабленном виде. Степень ослабления определяется тоном полупрозрачных участков маски. Если черный цвет соответствует нулевой проницаемости, а белый - 100-процентной, то 50-процентный серый задает ослабление вдвое. Чем темнее оттенок серого на маске, тем меньше краски попадет в этом месте на изображение.

Во многих случаях маски создаются на короткое время - пока выполняется одно или несколько действий. Потом сбрасываются. Однако часто возникает необходимость сохранить с трудом созданную маску надолго - до конца редактирования изображения или чтобы ею можно было воспользоваться в следующий раз, например. В большинстве редакторов растровой графики для этого предусмотрены команды сохранения и загрузки масок.

Записываются маски в виде полутоновых черно-белых изображений, по размеру совпадающих с той картинкой, для которой они создавались. Такое изображение-трафарет можно поместить в отдельное окно редактора и, следовательно, в отдельный файл на диске. Однако многие форматы графических файлов (в частности, TIFF) позволяют к основным цветообразующим каналам (красному, зеленому, синему) добавлять дополнительные. Помещенная в такой канал маска будет записана в том же файле, что и изображение.

Размещение масок в дополнительных каналах удобно при работе. К сожалению, при этом заметно увеличивается размер графического файла. Особенно, если маски сложные. Прибавление к трем цветовым каналам четвертого способно привести к увеличению размера файла на треть. 

Маски прозрачности 

Обычные маски ограничивают действие инструментов рисования, таких как карандаш, кисть, заливка, или фильтров. Маски прозрачности (transparency masks), применяемые во многих графических редакторах, включая Adobe Photoshop, задают прозрачность участков слоя, к которому они подключены.

В принципе обычные маски и маски прозрачности занимаются одним и тем же. Если в первом случае под воздействием, от которого надо защитить картинку, понимается изменение цвета, яркости и тому подобных параметров, то во втором таким воздействием является изменение прозрачности пикселов. Прозрачность в растровой графике такая же характеристика пиксела, как его цвет. Однако при большом сходстве есть и отличия.

Маска прозрачности отображается на экране только в виде черно-белого трафарета. Она не показывается штриховой линией. Редактируя маску прозрачности, можно наблюдать за появлением или исчезновением участков картинки там, где проходит кисть или карандаш. В наиболее сложных случаях, когда полагаться только на глаз недостаточно, можно вызвать маску прозрачности для редактирования в отведенном для нее дополнительном канале. При этом легче манипулировать полупрозрачными участками маски.

В палитре каналов маска прозрачности появляется только тогда, когда в палитре слоев выбран (активизирован) тот слой, к которому она прицеплена. Для каждого слоя Photoshop позволяет создать одну маску прозрачности. Нельзя этого сделать только для слоя Background, являющегося нижним при работе с изображениями в обычных растровых файлах. Под этим слоем ничего, кроме листа бумаги, быть не может, поэтому и прозрачным его делать нет смысла. 

Выделенные области 

Выделенные области (selections) в окне редактора отображаются точно так же, как и маски - штриховой линией. Однако выделенные области и маски - это не совсем одно и то же.

Например, выделенную область можно передвинуть на другое место, как будто она вырезана из картинки ножницами. На ее месте останется прозрачная дырка. При дублировании выделенной области дырки не остается, вы перемещаете копию выделенной области. Передвинутая выделенная область становится плавающей (floating selection), как бы поднимаясь над остальной картинкой на отдельный временный слой. Изображение под передвигаемым плавающим фрагментом остается в сохранности.

В отличие от выделенных областей, маски не предполагают использования для копирования и перемещения фрагментов изображения. Им отведена другая роль. В то же время выделенная область, как и маска, ограничивает действие инструментов рисования и фильтров. Даже при плавающей выделенной области вы можете рисовать только внутри нее.

Маски и выделенные области тесно связаны между собой. Маску часто получают на основе выделенной специальными инструментами области и, наоборот, выделение строят на базе хранящейся в отдельном канале маски. Благодаря возможности быстро переключаться с масок на выделения и обратно удается значительно упростить работу с растровой графикой.

К примеру, если выделенная область имеет нежелательную полупрозрачность или сопровождается ненужными участками-спутниками, их легко убрать карандашом, перейдя в режим рисования маски. С другой стороны, маски элементарной геометрической формы проще всего получить с помощью предназначенных для выделения инструментов.

Одним словом, понятия маски и выделенных областей настолько тесно переплетены друг с другом, что между ними зачастую не дела-ют различия. На всякий случай рекомендую запомнить, что маски не применяются для перемещения фрагментов, а выделенные области отличаются коротким сроком жизни и сохранить их можно, только преобразовав в маску. 

Инструменты выделения 

В Photoshop, как и в других редакторах, маски простейшей геометрической формы разумнее всего создавать с помощью инструментов выделения. Благо их набор проверен временем и они за годы существования графических редакторов стали очень удобными и мощными.
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Первый из этих инструментов - Marquee Tool. Он предназначен для рисования прямоугольных и эллиптических рамок, а также для выделения отдельных рядов пикселов (горизонтальных и вертикальных). Как и другими инструментами в Photoshop, управление им производится с помощью палитры Options.

В ней можно выбрать форму (shape) создаваемой рамки и задать принцип ее построения (style). Нормальный режим позволяет получить рамку произвольного размера, то есть соотношение сторон определяется тем, как далеко вы потянете мышкой курсор от одного угла рамки до противоположного. Предусмотрена возможность точно определить соотношение ширины (width) и высоты (height) выделяемой области. Этот режим называется Constrained Aspect Ratio. Наибольшую точность обеспечивает режим Fixed Size, в котором мышкой задается только угол рамки, а ее ширина и высота вводятся в соответствующие поля палитры Options вручную (в пикселах).

Для скругления углов выделяемой области задается радиус растушевки (feather). Если до создания рамки в это поле палитры Options поместить величину от 1 до 255 пикселов, у рамки получатся круглые углы с соответствующим радиусом.

Для эллиптических масок можно задать еще и сглаживание ступенчатости (anti-aliasing). При включенной опции Anti-Aliased крайние точки выделенной области делаются полупрозрачными и при ее перемещении сливаются с остальным изображением. За счет сглаживания удается автоматически обеспечить плавный переход между выделенной областью и картинкой, но у этого режима есть и оборотная сторона.

Сглаживание контура выделения часто приводит к появлению нежелательной каймы. Например, при переносе вырезанного фрагмента с темного фона на светлый при включенном сглаживании вокруг него появятся более темные, чем фон и сам фрагмент, пикселы. При преобразовании выделенной области в маску сглаженные пикселы получатся серыми, то есть полупрозрачными.

Для выделения областей произвольной формы применяются другие инструменты - лассо и волшебная палочка. Принцип их действия во многом схож. С помощью лассо пользователь обводит произвольный контур по опорным точкам. Контур замыкается автоматически двойным щелчком мышки. Затем рамка стягивается к середине, пока на ее пути не встретятся пикселы, цвет которых слишком отличается от начального. (К сожалению, в Photoshop нарисованная лассо рамка не стягивается. Исключение составляет случай, когда внутрь ее попадают абсолютно прозрачные пикселы.) 

Волшебной палочкой надо пометить пиксел в середине выделяемой области. После щелчка мышкой рамка начинает расширяться во все стороны, пока ей опять не встретятся слишком отличающиеся по цвету пикселы. Что значит "слишком"? Величину допуска задает пользователь в палитре Options, в поле Tolerance.

В Photoshop для волшебной палочки и для лассо можно включить сглаживание контура рамки. Для лассо, кроме того, задается скругление углов - в поле Feather.

Гибкость использования перечисленных инструментов обеспечивается тем, что выделяемые ими области можно складывать, вычитать друг из друга, получать пересечение двух нарисованных рамок. Сложение происходит при нажатой во время рисования рамки клавиши [Shift], вычитание - [Alt], пересечение - одновременно [Shift] + [Alt].

Обычно прямоугольная или эллиптическая рамка рисуется так: мышкой указываете на один из ее углов, затем, нажав и не отпуская кнопку мышки, перетягиваете курсор к противоположному углу (эллипсы при этом вписываются в полученный прямоугольник). Если определить место для угла рамки тяжелее, чем ее центр, надо нажать перед рисованием клавишу [Alt]. Разумеется, от центра можно нарисовать лишь первый эллипс или прямоугольник, так как потом [Alt] будет задействована для вычитания рамок. 

Рисование маски 

В современных редакторах растровой графики непременно предусмотрен режим рисования маски вручную. При этом используются все обычные инструменты рисования, в том числе карандаш, кисть, заливка, растяжка и т.д. Маска рисуется в специальном режиме, который в Photoshop называется Quick Mask и размещается в дополнительном канале.
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Рисовать вручную теоретически можно маски сколь угодно сложной формы, но на практике терпения (или здоровья) хватает на обводку предметов достаточно простой формы. Вырисовывать маску пиксел за пикселом может лишь женщина или настоящий гигант усидчивости.

Как это делается, давайте посмотрим на примере. На выбранной мной фотографии изображены два кусочка головоломки puzzle. Их форма достаточно причудлива, но в то же время проста, так как не содержит трудных для ручного рисования мышкой элементов. Попробуем их "вырезать".

Для перехода из обычного режима рисования в Quick Mask можно нажать на правую из двух кнопок внизу палитры инструментов или воспользоваться "горячей" клавишей [Q].

В режиме Quick Mask удобнее всего, на мой взгляд, пользоваться карандашом или кистью с жестким краем, инструментами рисования линий и заливки. Так как маска является черно-белой, предложена палитра от черного до белого цвета с градациями серого. Перед рисованием рекомендую заглянуть в палитру Options и убедиться, что для выбранного инструмента включена максимальная плотность (opacity).

Черным цветом, который в режиме Quick Mask будет представлен полупрозрачным красным, обычно лучше закрашивать вырезаемые элементы изображения, а не фон. Не беда, что полученная маска закроет, а не откроет выделяемую область - ее можно будет инвертировать с помощью команды меню Select/Inverse (клавиши [Ctrl] + [Shift] + [I]).
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Схема действий проста - сначала надо как можно точнее обрисовать выделяемый фрагмент по контуру, а затем залить его черным цветом. Прямые участки контура удобнее всего "проходить" инструментом рисования линий. Для него можно задать толщину (width) и сглаживание (anti-aliasing). Особенно приятно, что Photoshop показывает, как пройдет линия, еще до того, как вы отпустите кнопку мышки, благодаря чему ее можно провести по контуру очень точно.

Скругления углов выделяемого предмета и непрямые участки контура рисуются карандашом или кистью с жестким краем. Делается это по принципу лекала. Вы выбираете из палитры Brushes кисть такого диаметра, который как можно точнее совпадает с обводимым контуром. Тогда кисть не надо будет тянуть, достаточно щелкнуть мышкой - и часть контура готова. Переходите чуть в сторону - снова щелчок.

Если надо вырезать часть нарисованного или стереть неудачный мазок, переключите основной цвет на белый. Кстати, полезно проследить, чтобы для инструмента использовался именно черный и белый цвета, а не близкие к ним оттенки серого. Сбросить цвета кисти и фона на черный и белый можно клавишей [D].

Пока обводите контур, пользуйтесь увеличением в 200% и больше. Это даст вам возможность точнее воспроизвести сложный контур. Правда, на экране будет видна только малая его часть, но лучше почаще передвигать картинку линейками прокрутки, чем потом исправлять мелкие упущения.

После обводки кистью контура кусочков головоломки остается закрасить оставшиеся чистыми места посередине. Затем нажимаю клавишу [Q] и получаю выделенную область, которую надо инвертировать. Если потребуется, ее можно сохранить в виде маски.
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Должен заметить, что, назвав этот режим Quick Mask ("быстрая маска"), фирма Adobe погорячилась. Рисование маски вручную быстрым процессом никак не назовешь. Это довольно кропотливая и затяжная процедура. Однако к этому режиму приходится часто обращаться, когда надо подправить созданную другим способом маску. Вот это уже и в самом деле наиболее быстрый и легкий вариант. 

Создание маски по цветовому ключу 

К рисованию масок сложной формы вручную в режиме Quick Mask обычно приходится прибегать, когда другими способами задачу решить не удается. Один из наиболее популярных методов создания сложных масок базируется на включении в нее отдельных цветов изображения (Color Range).
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Чтобы ускорить процесс создания маски, следует внимательно посмотреть на картинку и прикинуть, каким способом лучше воспользоваться. Разумеется, полезна и доля везения. При удачном стечении обстоятельств, например, когда фон окажется приблизи-тельно одного цвета, который к тому же почти отсутствует в выделяемой области, стоит попробовать сгенерировать маску по цвету.

Окно создания маски по цветовому ключу вызывается через меню Select/Color Range. Для иллюстрации я, конечно, выбрал весьма удобную картинку, на которой фон составляет зеленая трава, а у девушки ни в костюме, ни в лице зеленого не наблюдается. Свежий цвет лица, должен заметить, в газете скорее всего не будет виден, к сожалению.

Вообще-то, выделять на фотографии людей - одна из самых неприятных задач. Контуры слишком сложны, да и столь существенная разница в цвете, как на выбранной мной фотографии, попадается не часто. Но в данном случае очень хорошо подойдет выделение по цвету.

В окне Color Range вам предстоит выбирать пипеткой цвет за цветом и изменять диапазон разброса включаемых в маску оттенков.
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Первый шаг - выбор наиболее общего цвета, входящего в маску. Делается это левой из трех пипеток. Нажав кнопку мышки, водите пипеткой по картинке и наблюдайте за изменениями в окне просмотра. Регулятор разброса оттенков (fuzziness) следует установить в среднее положение. Оптимальным начальным цветом является тот, при котором остается как можно меньше темных пятен на просветляемой части картинки (на ее фоне), а в выделяемой области - минимум серых полутонов.

Выбрав начальный цвет, попробуйте добиться наилучшего распределения включенных в маску и "оставленных на свободе" цветов, передвигая влево и вправо ползунок разброса оттенков. Только в идеальном случае удастся построить маску по одному цвету, поэтому не стоит отчаиваться, видя, что на фоне все равно остаются темные пятна, которые нельзя устранить, увеличив разброс, так как на выделяемом объекте немедленно появляются серые участки.

Дальше придется добавлять не попавшие сразу в маску цвета. Для добавления предназначена средняя пипетка, на ее кнопке еще плюс нарисован. Выбирайте этой пипеткой одно за другим пятна, оставшиеся на фоне, пока их количество не уменьшится до приемлемого. Под приемлемым я понимаю такое положение, когда их устранение вручную в режиме Quick Mask не вызовет затруднений.
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Если к маске добавлен цвет по ошибке или просто слишком сильно изменивший картину (не в лучшую сторону, конечно), можно удалить его. Для этого предназначена правая пипетка, на которой нарисован минус. К сожалению, пользоваться ею приходится редко. Работает она не очень эффективно, и во многих случаях удобнее и быстрее начать все сначала, чем пытаться найти именно тот цвет, который все испортил.

Большие неудобства вызывает регулятор разброса. Если бы он был сделан умно, то, после того как вы выбрали цвет, назначили для него разброс и перешли к следующему цвету, установки для предыдущего не менялись бы. Однако в Photoshop ползунком Fuzziness вы меняете величину отклонения для всех включенных в маску цветов, и в самом конце все может пойти насмарку.

Облегчает жизнь разнообразие режимов просмотра. Для картинки в самом окне Color Range не имеет смысла включать показ обрабатываемого изображения (Image), так как оно лучше просматривается в окне редактора. Зато для окна редактора можно включить показ создаваемой маски. Мне больше всего нравятся режимы, когда маска показывается, как в режиме Quick Mask, и черным или белым цветом. Выбирать цвета и контролировать процесс на большой картинке удобнее, чем на мелкой. При построении маски для данного примера мне постепенно пришлось уменьшить разброс оттенков со 100 до 20 и добавить к первоначальному цвету почти 20 оттенков. И все равно придется еще поработать над маской. Не получилось с отдельными прядями волос, их вынужден дорисовывать вручную. Не очистился полностью фон, так что и по нему надо пройтись кистью. И обязательно следует проверить качество контура, чтобы он не был слишком рваным и не захватывал лишнее. Все это предстоит делать в режиме Quick Mask. 

Если работать волшебной палочкой 

Выбор по цветовому ключу проходит далеко не всегда. Для него требуется, чтобы цвета в выделяемой области и на фоне не пересекались. Это довольно редкий случай. На выручку приходит волшебная палочка, действие которой подобно Color Range, но добавляемая к маске область ограничивается ближайшим серьезным цветовым переходом.

Возьмем для примера еще одну фотографию той же дамочки. На ней она изображена на сером фоне. Взяв в палитре инструментов волшебную палочку, открываем для нее палитру Options, чтобы оперативно изменять цветовой допуск - параметр Threshold.
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Сначала щелкаем палочкой на каком-нибудь участке фона. Если выбрано слишком много или слишком мало, изменяем величину допуска и снова щелкаем палочкой. Дальше надо будет добавлять к выделенной области новые участки, удерживая во время щелчка нажатой клавишу [Shift]. Каждый раз можно изменить величину допуска. Для этого следует отменить последнее действие, нажав клавиши [Ctrl] + [Z], в палитре Options задать новое число и повторно щелкнуть волшебной палочкой.

Присоединяя к маске участки фона один за другим, создаем в итоге выделенную область, охватывающую весь фон. В конце выделение надо инвертировать, чтобы получить маску не для фона, а для объекта. Работа тоже кропотливая, но зачастую более эффективная, чем при выборе по цвету. К тому же обычно не требуется дорисовывать маску вручную, так как необходимые уточнения вносятся на каждом шаге.
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При работе с волшебной палочкой больше всего неприятностей доставляют объекты, в которых много отверстий. Каждую такую дырку приходится помечать отдельно, что значительно увеличивает объем работ. С другой стороны, волшебная палочка не затрагивает маскируемый объект, благодаря чему часто можно обойтись вообще без доводки маски. 

Необычный способ рисования маски 

Разумеется, для каждого из описанных способов существуют условия, облегчающие выполнение задачи, и очень редко все складывается как нельзя лучше. Обычно ни один из вариантов не проходит идеально.

Но есть и совершенно другой путь создания маски, часто позволяющий получить желаемое без особых усилий. Он основан на том, что маска в общем-то совпадает с изображением. Чтобы получить маску, надо выделяемый объект закрасить белым, а фон - черным. Или наоборот, что несущественно, так как маску легко инвертировать.

Закрашивание объекта и фона - тоже весьма неприятная процедура. Выполнить ее инструментами рисования, такими как кисть или линии, то же самое, что нарисовать маску вручную. Упростить задачу можно, если для образца при раскрашивании взять не полную картинку, а один из ее цветовых каналов. Наиболее подходящим будет тот, на котором перепад полутонов между объектом и фоном окажется наибольшим.

Возьмем, например, ту же фотографию, на которой пробовали выделение по цветовому ключу. Давайте посмотрим, что творится у нее в цветовых канала. Открываем палитру Channels и последовательно просматриваем красный, зеленый и синий каналы. Ни на одном из них нет более серьезной разницы в оттенках на изображении девушки и на фоне, чем на общей картинке. Ничего не выйдет? 

Ошибаетесь. Давайте-ка переведем фотографию из модели RGB в CMYK. Добавился еще один канал, причем черный цвет перенесен в основном на соответствующий ему канал, а на голубом, пурпурном и желтом сосредоточена информация о цветах фотографии. Как видите, теперь появилась возможность упростить закрашивание объекта и фона, необходимое для создания маски. Предоставлена она желтым каналом.
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Перед тем как начать раскрашивать маску, надо выбранный для этого цветовой канал скопировать в дополнительный. Проще всего сделать это мышкой, перетянув его в палитре Channels на кнопку создания нового канала. Можно воспользоваться и командой Duplicate Channel из меню палитры каналов.

Для раскрашивания маски применяют не кисть и не карандаш (хотя к ним тоже иногда прибегают), а инструменты тонирования - затемнитель (Burn) и осветлитель (Dodge). Эти инструменты действуют по принципу изменения времени экспозиции (как в обычной фотографии). Можно также ограничить область их действия темной (Shadows), средней (Midtones) или светлой (Highlights) частью спектра.

Вернемся к примеру. Объект - девушку - надо осветлить до чистого белого цвета. Она и так уже светлее, чем фон. Исключение составляет разве что лицо, но с этим тоже можно разобраться. Применять инструменты тонирования будем с половинной силой, то есть с 50-процентной экспозицией. Светлые участки станем постепенно просветлять, а темный - затемнять. В результате должны получить изображение, состоящее только из черной и белой областей.
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Начинаем с просветления. В палитре Options для инструментов тонирования выбираем Dodge. Форма кисти - большого диаметра с мягким краем. Инструмент будем применять в светлой части спектра - выбираем Highlights. Установив все параметры, проводим несколько раз осветлителем по границе между объектом и фоном, следя за тем, чтобы выбеливался объект, а не фон.

Если действие Dodge ощутимо затронет пикселы фона, пора переключиться на затемнитель. В палитре Options выбираем Burn и темную область спектра - Shadows. Теперь проводим по границе между объектом и фоном затемнителем. Фон темнеет, как перед этим светлел объект, степень контраста постепенно увеличивается.

Вот так, чередуя Dodge и Burn, постепенно доводим границу между объектом и фоном до перепада между черным и белым. Остальные области (не соприкасающиеся) затемнить или осветлить еще проще.
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На нашей картинке есть два сложных участка. Изначально контраст между фоном и лицом модели, а также между фоном и ее руками не столь значителен, как на остальной части картинки. В этих местах надо орудовать инструментами Dodge и Burn осторожнее. Чаще переключаться с одного на другой, чтобы не испортить границу между объектом и фоном. При необходимости можно применить осветлитель и затемнитель не только в светлой и темной, но и в средней части спектра полутонов. Главное, чтобы после каждой манипуляции контраст увеличивался, а сама граница не менялась.

Маска путем затемнения и осветления областей на одном из цветовых каналов получается достаточно быстро. Немного потренируйтесь и потом будете строить маски без проблем. Главное - почувствовать, когда надо перейти на другой инструмент, чтобы не испортить границу между объектом и фоном. Обычно получается качественная маска, почти не требующая доводки. К тому же прилежания требуется не так уж много, рисование в режиме Quick Mask куда сложнее. 

Другие действия над масками 

Когда маска готова и записана в дополнительном канале, ее можно загрузить в виде выделенной области. Для этого применяется команда меню Select/Load Selection. По этой команде Photoshop предложит вам указать открытый в редакторе файл и канал в нем, из которого надо загрузить выделение. Если какая-то область уже выделена, загружаемую можно к ней прибавить, вычесть или получить их пересечение. При необходимости в момент загрузки дается возможность инвертировать выделение.
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Пользоваться командой Load Selection необязательно. Есть более быстрый способ получения выделенной области на базе одного из имеющихся в файле каналов. При открытой палитре Channels следует просто щелкнуть мышкой при нажатой клавише [Ctrl] по каналу с маской. Не требуется даже открывать палитру каналов. Комбинация [Ctrl] + [Alt] + # (где # - номер канала с маской) тоже загружает выделение из канала, если вы помните его номер.

Чтобы сохранить выделение в виде маски, надо воспользоваться командой Select/Save Selection, в которой выбирается один из открытых файлов и канал в нем. Процедура похожа на загрузку выделения, и если вы укажете не новый, а один из существующих дополнительных каналов, то сможете целиком заменить записанную в нем маску, прибавить к ней выделенную область, вычесть или записать пересечение маски и выделения.

Построенная маска обычно требует доводки. В Photoshop имеются средства для сглаживания границы выделенной области, удаления из нее черной или белой каймы.

Если контур выделенной области получился ступенчатым, что часто случается при рисовании вручную или при построении по цветовому ключу, полезно сгладить его командами Select/Modify/ Smooth или Select/Feather. Первая команда позволяет оптимизировать контур, уменьшив его ступенчатость в рамках задаваемого коридора. Ширина зоны сглаживания задается в пикселах. Команда Feather дает возможность скруглить углы выделения. Радиус скругления указывается в пикселах.

После применения команд Feather и Smooth вдоль контура выделенной области появляются полупрозрачные пикселы, обеспечивающие плавный переход между выделенным объектом и фоном. Но, как я уже говорил, это часто приводит к образованию вокруг объекта светлой или темной каймы.

В Photoshop есть средства автоматического удаления каймы - команды Remove Black (White) Matte из меню Layer/Matting. Действуют они не так, как в предыдущей версии редактора. Во-первых, для применения этих команд надо иметь объект, размещенный на отдельном слое и окруженный прозрачными пикселами. Во-вторых, все выделения должны быть сняты.

Таким образом, например, чтобы удалить белую кайму, придется выделенный объект перенести на новый слой. Сделать это можно командами Layer Via Copy или Layer Via Cut из контекстного меню, вызываемого правой кнопкой мышки. Затем следует сбросить выделение клавишами [Ctrl] + [D] и вызвать команду Remove White Matte.

Кайма удаляется также командой Layer/Matting/Defringe, которая позволяет задать ширину очищаемого поля в пикселах.

После рисования маски в ней часто оказываются лишние пикселы. Чтобы надежно удалить из выделенной области остатки фона, можно слегка расширить или сжать выделение. Делается это командами Expand (расширение) и Contract (сжатие) из меню Select/Modify. Вам надо указать величину в пикселах, на которую будет расширено или уменьшено выделение. Обычно достаточно 1 - 2 пикселов. После применения этих команд контур выделения немного сглаживается, но в нем не образуются полупрозрачные точки.

Как вы заметили, эти команды касаются выделенных объектов. Сделано это потому, что изменения легко перенести на маску командой Save Selection. Но кое-какие операции можно выполнить только над сохраненной в дополнительном канале маской.

Скажем, если в ней после рисования остались ненужные полупрозрачные пикселы, их проще всего удалить не в Quick Mask, а с помощью фильтра Threshold из меню Image/Adjust. Перед его вызовом, конечно, не забудьте открыть палитру Channels и перейти на канал с маской. В окне Threshold вы увидите гистограмму распределения полутонов. Под ней расположен ползунок, задающий точку, левее которой все оттенки серого станут черным, а правее - белым цветом. Передвигая этот регулятор, следует найти такое положение, когда в маске исчезнут ненужные точки, а контур останется без особых изменений.

Если вдоль границы маски надо получить полупрозрачные точки, лучше всего просто размыть фильтром Blur картинку в соответствующем канале. Такое размывание не выхолащивает контур выделенного объекта, убирая из него ступеньки и мелкие детали, в отличие от команд Smooth и Feather.

Поскольку в дополнительном слое с маской можно орудовать любыми инструментами и фильтрами, имеющимися в Photoshop, этот подход часто используется не только для вырезания объектов, но и для получения оригинальных эффектов. Но это уже совсем другая история.
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	Сейчас практически каждый человек, связанный с творческой деятельностью, стремится научиться работать с каким-либо из графических редакторов. Это связано с тем, что большую часть работы за него сможет выполнять компьютер, а как следствие - появится время, которое можно потратить более рационально. Действительно, зачем множество раз перерисовывать эскизы, которые отличаются друг от друга малыми деталями, если можно нарисовать заготовку, а затем, дублируя ее и внося некоторые изменения, довести работу до желаемого результата? Что же касается профессиональных дизайнеров, то тут компьютерная графика становится практически незаменимой. Пример? Пожалуйста. На днях один мой знакомый, занимающийся интерьером, восхищался программами трехмерной графики и никак не мог понять, как это раньше он обходился без них. Ему приходилось для каждого клиента рисовать десятки набросков, а то бывало и того хуже, клеить макеты. Сейчас же с появлением компьютера и навыков работы на нем многие его проблемы были решены, а силы стали направляться не на бессмысленное повторение эскизов, а на реализацию новых идей.
Это лирическое вступление ведет к тому, что компьютерные программы упрощают жизнь, одновременно умудряясь усложнять ее. Как говорится, с появлением компьютера мы научились решать такие проблемы, о существовании которых раньше даже не подозревали. Сегодняшняя статья посвящена одной из таких проблем.

Тема сегодняшней статьи будет интересна, я думаю, многим. Речь пойдет о текстурах. Как раньше мы поступали, когда все еще рисовали руками? Вся наша работа сводилась к тому, чтобы придумать, что же хотим получить, а потом попытаться как можно более мастерски передать желаемый эффект. Тогда мы даже не подозревали о такой проблеме, что уже созданная текстура может иметь слишком гладкий или шероховатый вид, узор может быть слишком крупный либо слишком мелкий, да и вообще рисуночек желательно бы заменить на такой, в котором будут преобладать те же объекты, но с более мягкими краями. Существует, конечно же, множество уже готовых вариантов, но никогда не знаешь, что может понадобиться в следующий момент, а если подходящей заготовки нет или она не совсем удовлетворяет требованиям, то приходится рисовать самому. Особенно это будет актуально для дизайнеров, работающих в Интернете и создающих Web-странички, и тех, кто имеет дело с трехмерной графикой, ведь любую текстуру, созданную в PhotoShop`е, можно накладывать на объекты, нарисованные, например, в таком популярном графическом редакторе, как 3D Studio Max.

Деревянная поверхность. 
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Как показывает опыт, эта текстура является наиболее часто используемой на практике. То есть, время от времени необходимо нарисовать что-то такое, в чем эта текстура - необходимое условие. Например, при создании рамок под фотографии или фона для интернет-странички.

Впрочем, возможны еще варианты использования готовой текстуры из клипарта или дополнительного плагина Eye Candy 4.0 (очень рекомендую, там можно регулировать не только цвет создаваемого изображения, но и многие другие параметры). Но чаще всего этой помощи под руками нет. Тогда и приходится рисовать руками, однако это совсем не тяжелый труд, в чем вы сейчас убедитесь.

Прежде всего, создайте новый файл в цветовой модели RGB Ctrl + N, либо File -> New (Файл -> Новый)). Изображение не стоит делать слишком большим, так как это отрицательно скажется на результате работы. Идеальный размер - 300 на 300 пикселей.

Залейте заготовку, используя инструмент Paint Bucket Tool (Ведро). Обратите внимание на цвет - цвет примера не является единственным возможным, я выбрала его совершенно случайным образом. Подбирайте цвет заготовки, исходя из того, какое дерево вам необходимо получить в конце работы. Если это дуб, то цвет должен быть взят из коричневых оттенков, если сосна - из светло-желтых, если вишня - из красных.

После того, как вы определились с цветом и залили заготовку, необходимо применить фильтр Add Noise: Filter->Noise->Add Noise (Фильтр->Шум->Добавить Шум). Величину (Amount) лучше всего определить на глаз, но рекомендую использовать значения 50-60. Зависит это исключительно от выбранного цвета и величины изображения. Обязательный параметр - Monochromatic (Монохромный), иначе нужный шум не выйдет, а вместо него на изображении появится множество других абсолютно ненужных цветов. Принцип действия данного фильтра описывался в одной из предыдущих статей.

В результате вы должны получить поверхность, несколько напоминающую панель из очень мелкой гранитной крошки.

Заготовку текстуры можно считать выполненной. Необходимо превратить эту непонятную поверхность в гладкую доску. Первый этап в этом - применение фильтра Motion Blur.

Запустите Motion Blur: Filter->Blur->Motion Blur (Фильтр->Размыть->Размыть в движении). Обратите внимание на то, что угол (Angle) необходимо выставить равным нулю, чтобы полосы прошли горизонтально, либо 90 градусам - и тогда деревянная доска будет расположена вертикально. Distance (Расстояние) установите равным ширине изображения.

После применения Motion Blur вы получите полосы, которые будут уже напоминать текстуру дерева. Но все же это сходство не очевидно, так как полосы очень кривые и неясные. Для исправления этого есть весьма хитрый ход, который применяется крайне редко за ненадобностью, но иногда и он приходится очень кстати.

Запустите фильтр Offset: Filter->Other->Offset (Фильтр->Другие->Смещение).

Параметры применения следующие: смещение по горизонтали - 75, по вертикали - 75. В результате применения этого фильтра вы получите изображение, разделенное на две части, одна из которых смещена относительно другой на 75 пикселей. Если результат не получился, то необходимо применить Offset еще раз, изменив параметры смещения, это может быть связано с индивидуальностью изображения.

Зачем все это делалось? Для того, чтобы нарисовать деревянные полосы более ясные и естественные, чем первоначальные.

Сейчас необходимо применить фильтр Motion Blur (Размыть в движении) снова. Настройки, скорее всего, подойдут прежние, но лучше не применять его без просмотра (Preview). Возможно, вам придется увеличить параметр Distance.

В итоге получится достаточно правдоподобная деревянная текстура.

Эта поверхность уже применима на практике. Больше всего она напоминает древо-стружечную панель. Так что, если вам необходимо использовать это в качестве текстуры при создании мебели, к примеру, в 3D Studio Max, то дальше можно не читать. Для наложения на объекты в трехмерной графике эта текстура подойдет значительно больше итоговой.

Для тех же, кто все-таки решил узнать, что будет дальше, сообщаю: сейчас мы будем заниматься приданием текстуре более естественного, природного вида. Для этого необходимо нарисовать места, где раньше были сучки.

Выделите небольшую область в середине изображения при помощи инструмента Elliptical Marquee Tool. Она должна быть не круглой, а несколько вытянутой горизонтально.

Примените фильтр Pinch: Filter->Distort->Pinch со значением Amount, равным -100.

Для выполнения этого действия вы можете использовать фильтр Spherize: Filter->Distort->Spherize (Фильтр->Искривление->Сферизация). Он делает то же самое, что и Pinch, но некоторым больше нравится.

Запустите Twirl: Filter->Distort->Twirl. Примените его на глаз.

Один узелок сделан. Вы можете ограничиться им, а можете создать множество разных размеров - все зависит от конкретной ситуации. Только один совет: чем меньше вы будете использовать симметрию в размещении, размерах и форме узелков, тем более реалистичным будет ваш труд. Не стоит ограничивать себя применением только перечисленных выше фильтров, может быть, поимпровизировав, вы найдете лучший способ имитации деревянных сучков. Для сравнения предлагаю вам посмотреть на иллюстрацию, которая была создана за пять-десять минут, а, следовательно, без особого усердия, а значит, если потрудиться, то можно сделать значительно лучше.

Эффект сделан полностью.

Multicolor 1.
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Ранее было описано много способов создания текстур, имитирующих какие-либо конкретные материалы. Сейчас же я хочу рассказать вам о том, как можно получить нечто очень яркое и фантастичное, явно к реальной жизни никакого отношения не имеющее. Я долго думала, какое название дать следующим двум текстурам, пыталась сравнить их с чем-нибудь, но так как результат данной деятельности был неудовлетворительным, то решила остановиться на нейтральном названии, которое подойдет к ним независимо от полученного итогового результата, который, как вы сможете убедиться, попытавшись создать нечто подобное сами, абсолютно не предсказуем. В этом заключается сложность такой работы, но вместе с тем и определенный интерес.

Первый рисунок будем создавать, используя всего один инструмент - градиент (клавиша, позволяющая выбирать его с клавиатуры - G).

Первый раз воспользуйтесь данным инструментом в стандартном режиме (Normal). Расцветку можно выбрать любую. Стиль определяется лишь вашим желанием. В данном примере был использован линейный градиент с переходом между красным, желтым, красным цветами. Первый шаг к получению результата сделан, но пока он выглядит не особо впечатляюще, посмотрим, что же будет дальше.

Все время после применялся радиальный градиент, режим которого был установлен как Difference (Различие). Данный режим инвертирует первоначальные цвета изображения, учитывая яркость накладываемых пикселей. Белый цвет полностью инвертирует нижерасположенные цвета, черный - вообще не изменяет их. Для того чтобы более детально разобраться в принципе действия данного эффекта, необходимо сравнить свое изображение, где присутствует только простой градиент с тем, на который уже наложен другой в вышеописанном режиме.

Далее можно использовать любые градиенты в любых режимах.

СОВЕТ

Не переусердствуйте с количеством и цветовым разнообразием градаций, так как в итоге цвета на изображении перемешаются и красивый оригинальный рисунок превратится в неизвестно что.

Изображение, которое представлено вашему вниманию, было получено при наложении нескольких градиентов разных цветов и стилей. Используя такой способ создания цветных изображений, можно получить множество замысловатых узоров и рисунков.

Multicolor 2.
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Следующий Background создавался при использовании большего количества инструментов и опций, но вся работа производилась в основных каналах, то есть в тех, которые формируют изображение. Наиболее просто достигнуть положительного результата можно при работе в цветовой модели RGB, состоящей из трех каналов: красного, зеленого и синего.

Я предлагаю начинать создавать изображение не с чистого листа, а с какой-либо иллюстрации. Так будет несколько проще сориентироваться, хотя для опытных пользователей данного графического редактора этот совет может быть несколько неактуальным.

Откройте готовое изображение либо создайте новый файл. Размер не имеет значения, однако цветовая модель должна быть RGB, CMYK или Lab.

Я создала исходный рисунок, используя линейный градиент, состоящий из большого количества цветов, которые практически полностью сохранились на итоговом изображении, и вы можете их там увидеть.

Откройте палитру каналов и, выбирая поочередно каждый канал, составляющий используемую цветовую модель, применяйте к нему различные фильтры и инструменты настройки изображения.

При этом действие применяемых опций будет распространяться не на все изображение, а на его отдельные цветовые составляющие.

Первый примененный мной фильтр был Twirl (Закручивание) из набора Distort (Искажения). Приводить параметры настройки данного фильтра не имеет никакого смысла, так как это не та текстуры, создание которой можно описать пошагово. Главное - это понять общий принцип работы, а дальше действовать, руководствуясь собственным вкусом и интуицией.

При работе с отдельными каналами можно использовать не только фильтры, но и различные способы редактирования, такие, как Levels (Уровни), Curves (Кривые), и другие инструменты цветокоррекции. Можно также выделять отдельные области и корректировать только их.

После таких преобразований у меня получилось изображение, показанное на рисунке. У вас, конечно, такой же результат не получится, но нечто подобное запросто.

Главная особенность двух вышеописанных примеров заключается в том, что, добившись какого-либо результата однажды, вам вряд ли удастся повторить его еще раз.

Развертка телевизора.
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Сейчас будет описано, как создать эффект развертки телевизора, или так называемые растровые строки. В реальной жизни это встречается в изображениях, скопированных с экрана компьютера или снятых при помощи видеокамеры, направленной на дисплей. Используется этот эффект достаточно часто, особенно в двух следующих ситуациях: вы рисуете дисплей непосредственно и хотите усилить реалистичность или пытаетесь сымитировать изображение, полученное вышеописанными способами. Не знаю, насколько данный эффект подходит к теме сегодняшней статьи, но все же, может, кому-нибудь будет полезен.

Откройте какое-нибудь изображение. При реализации данного эффекта в любом случае необходима готовая исходная картинка фотографического качества, иначе он теряет свой смысл. Сразу установите необходимый итоговый размер изображения, чтобы впоследствии не возникло проблем с размерами растровых строк (особенно это актуально при последующем увеличении изображения).

Откройте Image->Image Size (Изображение->Размер изображения). Посмотрите ширину (Width) своего изображения и запомните ее.

Создайте новую заготовку (Ctrl+N). Размеры должны быть следующие: ширина (Width) равна ширине исходного изображения, а высота (Height) равна четырем пикселям.

Используя инструмент Rectangular Marquee Tool (Прямоугольное выделение), создайте выделение в два пикселя высотой и на всю длину изображения. Для удобства лучше увеличить картинку горячим сочетанием клавиш Ctrl + "+". Залейте выделение темно-серым или черным цветом, используя инструмент Paint Bucket Tool (Ведро).

Это будет заготовка для работы по созданию строк.

Сейчас мы будем использовать очень полезную функцию - заливку по образцу. Если раньше вы не встречались с подобным способом решения поставленной задачи, то рекомендую обратить внимания, так как он применяется довольно часто.

Прежде всего, выделите все изображение (Ctrl+A).

Затем определите образец по выделению: Edit->Define Pattern (Правка->Определить образец). Имя укажите "Line".

Теперь файл с линиями можно закрыть. Он нам больше не понадобится.

Сделайте исходное изображение активным. Перейдите в палитру слоев (Layer), в которой необходимо создать новый слой, нажав кнопку "Create a New Layer". Он будет рабочим.

Теперь необходимо использовать Fill: Edit->Fill (Правка->Залить). В качестве параметра Use (Использовать) поставьте Pattern (Узор) и выберите созданный образец, который добавился к уже имеющимся.

В результате применения этой функции вы получите результат практически аналогичный тому, который показан на рисунке.

В качестве основного инструмента, который доведет работу до логического завершения, используйте Levels (Уровни). Запустите Уровни: Image->Adjust->Levels (Изображение->Настройка->Уровни). Примените этот инструмент с настройками, которые лучше установить на глаз, к тому же, если у вас выставлена галочка "Preview", то вы сможете видеть все изменения.

Можно повторно применить данный инструмент, предварительно склеив слой с первоначальным изображением со слоем со строками.

Вот и все. Эффект сделан.

На этом данная статья себя исчерпала и подошла к логическому завершению. В следующий раз я отвечу на наиболее часто встречающиеся вопросы читателей, так что пишите.
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Объекты из стекла можно конечно делать на 3D редакторах, например 3D Studio Max и других, но Photoshop тоже кое-что может. Вот образец такой вот кнопочки из стекла. Времени на ее изготовление требуется порядка 3-5 минут. Визуализация делается при помощи наборов фильтров Eye Candy 3.0, он должен быть установлен в Photoshop.

Для начала, берем бэкграунд, на который нужно положить стеклянную кнопку. Делаем прямоугольное выделение, соответствующее размеру будующей кнопки. На всякий случай сохраняем выделение в альфа-канал. (лучше привыкнуть сохранять выделения, которые могут в последствии понадобится сохранять в альфа-канале). Копируем это выделение в буфер. Создаем новый рисунок. Так, как в буфер копировался выделенный фрагмент, автоматически предложено будет создать рисунок размером, совпадающим с размером сохраненного выделения. Затем вставляем сохраненный фрагмент в новый рисунок. Сразу после чего соединяем все слои.
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Далее создаем еще два рисунка того же размера. Перый рисунок с черной заливкой, второй - цветом предполагаемого цвета стекла. В данном случае зеленой. Переходим в режим "Быстрая маска" , устанавливаем инструмент "Градиент", причем маска должна быть 100% непрозрачной, а градиент от черного до белого. Делаем градиент на рисунке из черного фона. Должно получиться как показано на рисунке.
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Теперь выходим из режима "Быстрая маска" должно появиться выделение на черном рисунке в виде прямоугольника ближе по размерам к квадрату. Копируем в буфер картинку с изображением фрагмента бэкграунда и вставляем его в выделение на черной картинке. 
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Если вы все сделали правильно, то должно получиться приблизительно так. Теперь накладываем поверх этой картинки новый слой из картинки с цветным фоном, в данном случае зеленом. Здесь кому как удобно, и кто как привык. Можно просто добавить новый слой и залить его определенным цветом. Тем не менее у нас теперь добавился слой и он наверху. Делаем ему прозрачность приблизительно 15%, в данном примере 14%. Получается Бэкгаунд с градиентным освещением и зеленоватым оттенком. Соединяем все слои. Это нужно не забыть сделать, так, как на это изображение в целом будем копировать в буфер, предварительно его полностью выделив.
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Замечательно. Теперь у нас в буфере хранится исходная картинка, над которой и будем колдовать. Создаем новый рисунок с черным цветом фона. А вот размер его должен быть на 1/3 больше исходного. Так, если одна сторона исходной картинки =100 пикселей, то при установленном флажке "Сохранять пропорции" нужно поставить порядка 135 - 139 пикселей - это самое оптимальное. После чего вставить сохраненный рисунок. Вот так приблизительно и должно получиться, как показано на рисунке. Самое главное. ВНИМАНИЕ: Нажмите ctrl и удерживая ее щелкните по новому появившемуся слою во вкладке слои, тоесть по картинке, которую только что вставили. Сохраните это выделение в альфа-канал. Теперь соедините все слои. Заготовка готова. 
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Снимите выделение с рисунка и примените фильтр Eye Candy Water Drops. "Капли воды" Причем настройте на всего одну каплю. Преломление можете ставить какое нужно. Если под кнопкой будет текст, то меньше, а если обычный бэкграунд. то можно и по более. На рисунке изображено несколько не верно. Слои не соединены. Этот рисунок был сделан несколько раньше, немного не усмотрел. Должно на превьюшке быть подобие стеклянной кнопки на черном фоне
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Теперь восстановите выделение из альфа-канала. Просто щелкните по нему во вкладке "Каналы" удерживая клавишу Ctrl. (Надеюсь вы сохранили выделение, я предупреждал. . .) И далее к выделенному фрагменту примените фильтр "Eye Candy - Inner Bevel". Приблизительные параметры изображены на рисунке.
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Теперь остается копировать выделенную часть в буфер и перенести на исходный бэкграунд. Получилось? Пользуйтесь. Ниже приведены мои небольшие опыты с подобным эффектом. Сделано все по схеме, приведенной выше.
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	До сих пор компьютерная графика остается весьма сложным и трудоемким процессом. Что трудности отпугивают случайных "юзеров", полезших в Photoshop даже не из любопытства, а просто от нечего делать, это неплохо. Но ведь и профессиональным художникам приходится несладко.
Мало того, что им необходимо что ни день придумывать новые варианты дизайна, композиции и постоянно искать оригинальные решения, чтобы конечные продукты их труда - будь то рекламные объявления, книги, журналы, Web-страницы или что-либо другое - не выглядели как сошедшие с конвейера автомобильного завода "Жигули".

Авторы графических редакторов, конечно, прилагают максимум усилий, чтобы автоматизировать выполнение рутинных операций и дать художникам возможность сосредоточиться не только на технической, но и на творческой стороне работы. Посмотрите, например, сколько действий выполняется в том же Adobe Photoshop не только вручную, но и автоматически.

С другой стороны, автоматизация никогда не будет доведена до такого уровня, чтобы можно было сказать машине "я хочу...", а она сразу все сама и сделала. Базовый инструментарий графических редакторов помогает справиться с коррекцией экспозиции, с простой ретушью, предоставляет джентльменский набор спецэффектов, которые могут послужить подспорьем при реализации сложных проектов. Однако это всего лишь инструменты, такие же, скажем, как кисти у художника или ноты у композитора. Комбинировать приходится человеку.

Несколько большие возможности для творчества предлагают подключаемые дополнения-plugin'ы. Они автоматически выполняют над изображением ряд "элементарных" действий, в результате чего возникает тот или иной, но заранее придуманный авторами модуля, эффект. Это уже автоматизация на более высоком уровне. Располагая набором хороших plugin'ов и досконально зная, что с их помощью удастся получить, художник может сосредоточиться на разработке сюжета, концепции и т.п. При хорошей проработке замысла с учетом возможностей инструментария львиная доля работы будет выполнена этими модулями-дополнениями.

Сегодня я хочу представить вам два не так давно появившихся plugin'а, созданных компанией Ulead, опыт которой в компьютерной графике не вызывает сомнений, а репутация очень высока. Сейчас вы сами убедитесь, что ее модули оправдывают ожидания профессионального художника и способны оказать очень серьезную помощь новичку, который хочет с самого начала производить качественные вещи. Этим они отличаются от полчищ левой ногой сваянных plugin'ов, которые как великая ценность передаются на компактах друг другу далекими от настоящей графики фанатиками-собирателями.

[image: image41.jpg]etz
SE=—=ip =
ol 5
Ui 59
S—— 3
oo
 suon A
s
Cseo B

Gl Entors





Ulead Type.Plugin
Этот модуль предназначен для работы с надписями, но может применяться и к другим объектам - значкам, логотипам и т.п. Чтобы запустить данный модуль, надо либо выделить некоторую область (это может быть маска, построенная на основе текста), либо иметь объект (тот же текст) на прозрачном слое, тогда программа построит маску сама.

Модуль Type.Plugin включает 14 различных эффектов, охватывая практически все мыслимые манипуляции с надписями. Это очень мощный инструмент, так как для каждого эффекта в окно выводятся свои настраиваемые параметры и есть возможность пополнить галерею эффектов удачными находками.

Как и в остальных plugin'ах от Ulead, диалог прост, не перенасыщен загадочными регуляторами, действие фильтра можно моментально увидеть в кадре просмотра. Работает все быстро и надежно.

Теперь я хочу подробнее остановиться на предлагаемых Type.Plugin эффектах.
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Gradient
Это очень простой эффект - растяжка, или градиентная заливка. Он позволяет создавать надписи, плавно вырастающие из фона. Предлагаются три варианта растяжек: линейная строго сверху вниз, прямоугольная от краев к центру и такая же радиальная. Для заливки можно выбрать исходный цвет, в качестве второго цвета принимается цвет фона, установленный в Photoshop. Если опция Fill Color не активизирована, цвет заливки берется с изображения. Для градиента выбирается начальное и исходное значение цвета. Обе величины задаются в пределах 0 - 255.

Наиболее интересные вещи при помощи этого эффекта получаются, когда вы не выбираете цвет заливки, выделенная область содержит растровое изображение, а не просто одноцветна.
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Hole
Как следует из названия, этот эффект подобен дыроколу. Суть его состоит в том, что выделенная область изображения (текст) заполняется по образцу кружками, квадратиками или более сложными элементами. Их, кстати, вы можете создавать сами и добавлять к фильтру.

Так же, как и в предыдущем случае, имеется опция FIll Color, позволяющая задать цвет заливки. Если она не активна, берется исходное изображение со слоя, к которому применяется эффект. Образцы заливки можно инвертировать, то есть, скажем, вместо белых кружочков на прозрачном получить прозрачные кружочки на белом.

Остальные настройки выполняются с помощью двух ползунков. Первый (Size) позволяет масштабировать образец от 1 до 100%. Второй (Variation) управляет размещением образцов. При минимальном его положении образцы выстраиваются строго в ряд, при максимальном они размещаются чисто случайным образом.
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Glass и Metal
Это очень похожие эффекты, создающие характерную окантовку вокруг выделенной области или текста. Сами буквы становятся прозрачными. Окантовка размыта и напоминает свечение. Если эффект Glass еще как-то смахивает на стекло, то Metal у меня никаких ассоциаций не вызывает. Для Glass можно выбрать цвет окантовки. В обоих случаях с помощью ползунков изменяется количество отражений (Reflection) и мягкость краев маски (Fuzziness).
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Emboss, Emboss-Outline и Emboss-Texture
Название этого эффекта говорит само за себя. Правильно, он позволяет получить выпуклые буквы. Содержимое выделенной области, как и окружающего ее фона, сохраняется, в отличие от действия одноименного стандартного фильтра Photoshop. Просто добавляются освещенные и затененные участки, создающие иллюзию выпуклости.
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Задается форма фаски по краю объекта (скругленная, с выемкой или прямая), направление освещения, степень контраста между тенями и фоном, а также толщина выпуклости. Этого достаточно для получения именно такого выпуклого текста, как вы задумали. Две разновидности фильтра позволяют получать очень интересные результаты.

Эффект Emboss-Outline делает выпуклыми не сами буквы, а только их контуры. Как и в "родительском" эффекте, в данном случае можно настраивать толщину выпуклости, направление падающего света и контрастность теней, но форму края изменить нельзя - он строго острый, треугольный.
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С помощью Emboss-Texture получаются самые интересные вещи. В этом фильтре, как и в Hole, выбирается образец, по которому будет строиться рельеф. Так сказать, карта выпуклостей, если обратиться к терминологии 3D-графики. К имеющимся образцам можно добавить свои, они просто должны быть записаны в BMP-файлы.

Настройки для Emboss-Texture включают, кроме выбора образца, его масштабирование, прозрачность и контрастность. О форме краев, направлении света и толщине речь уже не идет. В принципе, это правильно, так как и без того есть возможность получить очень занимательные результаты.
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Concrete
Данный эффект заключается в придании тексту неровных краев, как бы из крошащегося бетона. Снова Ulead предлагает необходимый минимум настроек: степень неровности Roughness (чем больше эта величина, тем отчетливее проявляется эффект), направление освещения Light Direction и цвет источника света, падающего на объект немного спереди.

Причем цвет в этом фильтре надо выбрать обязательно, нейтрального не существует. Если установить белый, то все равно буква будет подкрашена серыми тенями, как и должно быть при освещении точечным источником вроде лампы.

Это довольно интересный эффект, хотя в большинстве случаев результаты не ассоциируются с 

чем-либо натуральным. Замечу также, что его лучше применять к закрашенным буквам.
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Sand
Сильно напоминает Emboss-Texture, но лишен большинства настроек и работает не с подгружаемыми битовыми картами, а с генерируемым программой шумом. Внешне сходство с песком есть, но, к сожалению, цвет "виртуального песка" нельзя выбрать в самом фильтре, поэтому надо тщательнее готовить исходное изображение и покрасить буквы в требуемый цвет еще на слое Photoshop.

Управление очень простое и сводится к выбору направления освещения и степени неровности "песка" внутри букв.
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Lighting
За скромным названием этого эффекта скрывается не просто освещение, а очень любимый многими начинающими дизайнерами прием. Он позволяет сделать буквы псевдотрехмерными, похожими на изготовленные из полированной пластмассы или металла.

Настройки включают управление положением точечного источника света (угол и высоту над плоскостью, в которой лежит объект), выбор цвета для него, цвета поверхности букв, можно применить к их поверхности карту выпуклости (Bump Map). Наложение рельефа не очень оправданно, так как при этом пропадает выпуклость букв и результаты напоминают работу Emboss-Texture, только у того гораздо больше возможностей.

Зато без карты неровностей вы можете получить весьма приличные надписи с фальшивой позолотой. "Братки" будут в восторге.
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Fire
Ну вот, добрались и до самых художественных эффектов, предложенных Ulead в этом plugin'е. С помощью эффекта Fire, как нетрудно догадаться, надпись можно "поджечь". Причем, в отличие от множества других фильтров такого же назначения, вы получите немного утрированный, излишне декоративный, но зато легко опознаваемый огонь.

Чтобы не смущать пользователя фиктивным богатством возможностей, фирма Ulead вновь ограничилась самыми главными настройками. Можно выбрать цвет пламени в трех точках - по краю, в середине и на поверхности объекта. Ползунком задается сила огня, то есть длина языков пламени. Увлекаться с этой настройкой не стоит, так как при минимальных значениях вы получаете наиболее похожий на правду эффект.
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Snow
Коль есть пламя, то Ulead нельзя было пройти мимо его антогониста - льда. Правда, сей эффект назван снегом, но судите сами, что он вам больше напоминает.

Будучи прямой противоположностью пламени, снег-лед так и сделан. Настройки те же - три цвета и длина свисающих сосулек. Очевидно, что для Snow авторы применили тот же алгоритм образования языков, что и для Fire, но только повернули их вниз.

Получилось то же самое. Не слишком натуралистично, зато легко узнаваемо. Что и требуется при оформлении шапок и заголовков, когда не стоит слишком ударяться в имитацию природных материалов и предметов, ведь текст никто не будет рассматривать как мадонну Рафаэля - его прочитают.
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Neon
Эффект, многократно реализованный авторами как самопальных, так и фирменных plugin'ов, на мой взгляд, лучше всего получился у Ulead. Фильтр прост, как грабли. Настройки предоставляют вам выбрать цвет неоновой трубки и силу исходящего от нее света, иначе говоря, его рассеяние. Чем эта величина больше, тем сильнее проявляется эффект, но есть риск лишить картинку правдоподобности.

Это все регулировки! Остальное - варианты. Если выбрать режим Inside, получится надпись, когда буквы вырезаны в цельном листе, за которым спрятана неоновая подсветка. При режиме Outside надпись выполнена из отдельных непрозрачных букв, но источник подсветки по-прежнему спрятан за ними. Оба варианта вы тысячу раз видели на улице. Both Sides - третий режим, который имитирует буквы, изготовленные из неоновых трубок. Самый, так сказать, дешевый вариант, но требующий точного подбора силы свечения.

Эффект Neon лучше всего применять, когда за надписью расположена вполне материальная поверхность, так как у Ulead особенно хорошо получились отбрасываемые на "стену" отсветы.
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Seal
Последнее "чудо" от Ulead имитирует отпечаток штампа. Не скажу, что это получилось правдоподобно. Любой специалист по подделке документов высмеет эти потуги. Но, с другой стороны, не в реалистичности ведь дело. Просто это способ получать оригинальные красивые надписи.

Настройки позволяют выбрать цвет для заполнения буквы и "давление" на штамп, от которого зависит его "прилипание" и, соответственно, насколько плотно будет закрашена буква.

Как видите, Ulead Type.Plugin - мощный инструмент для знающего свое дело оформителя. С его помощью можно снять массу вопросов по оформлению рекламы и заголовков печатных изданий. Причем при абсолютной простоте интерфейса этот plugin оставляет свободу для творчества. Кроме изменения предложенных параметров, что уже само по себе позволяет получить оригинальные результаты, можно создать обширную библиотеку образцов и за счет этого существенно расширить функциональность половины эффектов.

Кроме того, Type.Plugin позволяет автоматизировать работу. Он поставляется с библиотекой вариантов настройки фильтров, вызываемой кнопкой Load. В эту библиотеку вы можете помещать свои удачные находки, нажимая на Add.

В отличие от "левых" plugin'ов, продукты от такой солидной фирмы, как Ulead, не могут поставляться без справочника Help. В данном случае он тоже имеется, но уж очень лаконичный, так что практически ничего нового вы из него не узнаете. Сведения ограничиваются описанием назначения параметров, нет никаких полезных рекомендаций и, что очень хотелось бы, примеров или идей по творческому применению предложенных эффектов.
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Ulead Particle.Plugin
Если описанный выше модуль предназначен для оформления отдельных объектов, то Particle.Plugin работает с картинкой в целом и обеспечивает более сложные эффекты. Не с технической точки зрения, а с художественной, поскольку их труднее использовать в общем замысле композиции.

Как следует из названия, компания Ulead предложила набор эффектов, базирующихся на мелких объектах-частицах. Под частицами понимаются внешне совершенно разные объекты, общее между ними то, что каждую из них можно передвигать, их размеры, количество и размещение генерируются модулем автоматически. Каждая из частиц в этом plugin'е представляет собой достаточно сложный объект, имеющий свой набор цветов, прозрачность, характеристики преломления и т.п.

Как и Type.Plugin, модуль Particle.Plugin отличает некоторая декоративность. Можно даже утверждать, что это дополнение не рассчитано на имитацию реалистичных картин. И создаваемые в нем звездочки, и туман, и фейерверки придают работе как бы сказочный вид. В стиле Диснея он работает, что ли?

Второе принципиальное отличие, не бросающееся, правда, в глаза, - этот модуль не дает вам возможности добавлять свои частицы и таким образом наращивать его мощь. В принципе, это можно было сделать, но Ulead посчитала, что с вас и так хватит. Тоже верно. Попробуйте работать с имеющимися эффектами и поймете, что даже если просто записывать на будущее удачные варианты, то и это позволит создать неслабую галерею спецэффектов.

Итак, что же нам предлагают.

[image: image56.jpg]



Bubble
В Particle.Plugin всего восемь вариантов частиц, и первый из них - пузыри. Пузырь всегда привлекал внимание компьютерных художников. При кажущейся простоте формы он является очень сложным с точки зрения имитации объекта. Вручную построить правильный пузырь практически невозможно, или, по крайней мере, не имеет смысла тратить на это несколько дней. Ведь есть инструменты, которые делают это автоматически. Particle.Plugin - один из лучших.

Его настройки разделены на две группы. Первая управляет эффектом в целом. Тут имеется возможность изменить число пузырьков, задать для них максимальный размер и диапазон изменения размеров, установить коэффициент отражения света от поверхности.

Вторая группа настроек управляет характеристиками отдельной частицы. Для нее задается персональное цветное освещение (рассеянным светом), выбирается цвет тела частицы и ее границы, а также сила точечного освещения. В моей версии plugin'а регуляторы цвета края и тела перепутаны - когда задаете цвет края пузырька, меняется его внутренний цвет, и наоборот. Впрочем, это ерунда. Привыкнуть можно.

Для каждой частицы можно подобрать угол и высоту расположения источника точечного освещения. Правда, когда вы имеете дело с десятком-другим пузырей, делать это нецелесообразно, да и свет в обычных условиях падает на все объекты одинаково. Другое дело, если вам нужен всего один здоровенный пузырь. Тогда имеет смысл подобрать параметры тщательнее.

В этом эффекте применяется генератор случайного размещения частиц. После его срабатывания каждую из частиц можно передвинуть вручную. Чтобы выбирать пузыри было удобнее, окно просмотра переключается на режим Wireframe, в котором пузырьки не прорисовываются, а показаны только квадраты, соответствующие их размеру. С помощью специальных кнопок можно передвигать пузырьки не только в плоскости изображения, но и по третьей оси - на передний или задний план, на один вверх или вниз.

Похоже, что на рекламе стиральных порошков, имея этот plugin, можно заработать на жизнь.
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Firefly
Фейерверки очень похожи на пузырьки. Это тоже объекты круглой формы, но не имеющие четкой границы - окруженные свечением яркие цветные точки.

Управляя этим эффектом, в отличие от предыдущего, вы не оперируете отражающей способностью, поскольку отражений просто нет. Для каждой частицы фейерверка задается цвет и прозрачность. Есть еще параметр Softness, от изменения которого зависит интенсивность свечения вокруг ядра частицы.

Когда программа генерирует эффект случайным образом, она не только подбирает размер и размещение частиц, но и вовсю пользуется цветом. Если пузыри вы получали одного окраса, то теперь не пугайтесь, когда зарябит в глазах. На то это и фейерверк.

Эффект очень интересный, выразительный, с хорошими перспективами применения в творческих работах, но совершенно не напоминающий реальные фейерверки. Разве что если смотреть на салют через запотевшее стекло, да еще и в сильно "приподнятом" состоянии духа...
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Rain
А в этом случае приходится иметь дело с частицами не круглой, а сильно вытянутой формы. Генерируемые фильтром штрихи призваны изобразить струю дождя. При старании и некоторой доли везения (удачный фон) удается получить очень даже реалистичную картинку.

Совсем другое управление. Главное, что вы не можете управлять частицами-струями индивидуально. Да это вам и не по силам. И не требуется. Достаточно общего управления, которое включает настройки количества, наибольшей длины и ширины штрихов, диапазон изменения их размеров. Забавно, что изменить угол наклона дождя нельзя. Если ветер на вашей фотографии будет дуть в одну сторону, а струи потекут в другую, получится очень смешно. Рекомендую в таком случае предварительно зеркально повернуть снимок.

Хотя частицами и нельзя управлять индивидуально, можно кнопкой случайной генерации Random попытаться подобрать лучшее размещение струй. Кроме того, есть возможность изменять цвет и оптическую плотность (непрозрачность) частиц, а также степень размывания фона (вода глаза заливает?).
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Snow
Снег, как известно, это тот же дождь, но в более холодную погоду. Близость имитируемых явлений нашла отражение в сходстве фильтров эффектов. Как и предыдущий, это эффект отличается возможностью создания вполне правдоподобных картинок.

Настроек в нем меньше. Хлопья снега хоть и неправильной формы, но все же вполне описываются одной величиной, поэтому имеются регуляторы их количества, максимального размера и диапазона его изменения. Для частиц можно задать цвет, получив снегопад в окрестностях промышленного гиганта (известно, что снег в таких местах бывает и синим, и зеленым, и красным). Последний регулятор предназначен для изменения плотности снежных хлопьев. Фон, в отличие от предыдущего эффекта, не размывается.

Хотя и не по сезону, но это очень полезный эффект. Пройдет полгода, и все дизайнеры займутся рождественскими и новогодними мотивами. Самое неприятное, что за год удается потерять все наработанное в прошлом предпраздничном сезоне. Каждый год народ заново рисует свечи, шарики, елки, снежинки, сугробы и толпы дедов-морозов. Particle.Plugin окажется отличным подспорьем.
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Cloud и Smoke
Эти фильтры имеют совершенно одинаковое управление и генерируют похожие эффекты. 
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Похожие, но не одинаковые. В первом случае облака имеют тенденцию к растягиванию по горизонтали, а во втором дым пытается струиться вверх. Это единственное обнаруженное мною отличие, все остальное одинаково.

Снова появилась возможность возиться с частицами по отдельности. Причем игра стоит свеч, так как случайное расположение облаков редко вписывается в пейзаж, а дым почти всегда не так обтекает предметы, как хотелось бы.

Управление эффектом опирается на регуляторы числа частиц, их максимального размера и диапазона изменения размера при работе генератора случайного размещения. Для всех частиц скопом можно выбрать цвет и оптическую плотность, сглаживание по горизонтали и вертикали, а также частоту. Последний параметр очень важен и интересен. Он определяет количество разрывов в облаках или в струйках дыма. Чем разрывов больше, тем динамичнее выглядит картинка. При минимальных величинах вы получаете длинные мягкие ровные струи.

Если же выбрать отдельную частицу, то поменять для нее можно будет лишь цвет. Не думайте, что это ограничивает полет фантазии. Изменения цвета достаточно для имитации предгрозовой обстановки в небе или разноцветных струй дыма на шабаше наркоманов.

Нюанс: цвет менять надо в самый последний момент, когда все остальное подобрано, иначе он для всех частиц снова будет назначен один.
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Fire
Этот эффект почти не отличается от описанных выше Cloud и Smoke по управлению и принципу работы, но кое-какие нюансы есть. Во-первых, нельзя управлять цветом частиц. Огонь всегда красный с желтым. Это не совсем удачное решение, лучше сделать так, как в одноименном эффекте Type.Plugin. Выбрав отдельную частицу, можно передвинуть ее в сторону или изменить ее прозрачность.

Эффект красивый, позволяющий нарисовать почти натуральный костер. Его ценность увеличивается при согласованном применении эффекта дыма и удачном подборе фонового изображения.
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Star
Последний эффект имитирует яркие звезды. Не те, что на башнях Кремля, а те, что в небе. Правда, звезды получаются волшебными, уж очень правильными и яркими.

Звезды в этом фильтре тоже можно передвигать вручную и задавать для каждой из них оригинальные параметры. Причем настроек в данном случае больше, чем обычно, и только два параметра не применяются при изменении отдельных частиц, а действуют на все сразу. Это число звезд и диапазон изменения их размера.

Остальные параметры можно изменять для каждой звезды индивидуально, так же как и для всех вместе. К ним относятся в первую очередь размер звезды в целом (включая гало) и число лучей. Во вторую очередь в глаза бросаются еще три размера - размер ядра звезды, диаметр ее гало и длина ее лучей. Для каждого из этих элементов частицы можно выбрать свой цвет. Следует только учитывать, что красная звезда с синими лучами и зеленым гало выглядит пугающе.

Параметр Star Ratio определяет соотношение длины четных и нечетных лучей. Рекомендую его изменять, тогда картинка получится более живой. Регулятор Direction в других эффектах фильтра Particle.Plugin, за исключением Bubble, не применялся. Он задает угол поворота частиц-звезд. Зато Opacity - оптическая плотность - есть в каждом фильтре.

Вот, собственно, и все эффекты модуля Particle.Plugin. Фирма Ulead постаралась сделать высококачественный продукт, и это ей удалось. Приятно, что даже при построении сложных объектов от вас не требуют разбираться в двух десятках настроек. Оставляя пользователю возможность регулировать только самые необходимые параметры, программа автоматически создает очень интересные эффекты. В некоторых из них, я считаю, модулю от Ulead нет равных.

Самое тяжелое при работе с этими дополнениями - научиться грамотно использовать их возможности, органично вплетая автоматические эффекты в общую канву вашей работы.

Остается добавить, что вы можете попробовать эти фильтры в деле. Их бесплатная 15-дневная пробная версия имеется на Web-сайте компании Ulead по адресу http://www.ulead.com/webutilities. Там вы обнаружите еще пачку plugin'ов, с которыми я собираюсь познакомить вас в скором будущем. 

	Трюки и спецэффекты в Photoshop 5.5 (часть 4)
2002-08-15


	Автор: Галина Корабельникова 
	Страницы: [1] 

	
	Комментарии [0] 

	


	Бесспорен тот факт, что при создании сложных визуальных эффектов лучше всего воспользоваться возможностями, предоставляемыми пакетами с трехмерной графикой. При помощи этих программ можно довольно быстро и правдоподобно воссоздать такие сложные эффекты, как огонь и лед, туман и россыпь искрящихся капель росы, взрыв и проливной дождь. Но многим эти программы не доступны, а некоторым они просто не нужны. Если вы работаете с PhotoShop, то вам вовсе не стоит отказываться от всех вышеперечисленных возможностей реализуемых в трехмерной графике. Наберитесь немного терпения и фантазии, и все получится. Вам не придется прикладывать столь грандиозные усилия, которые понадобились бы при овладевании трехмерной графикой.

Хотя PhotoShop двухмерный графический редактор, но благодаря огромному количеству фильтров, инструментов, настроек он позволяет добиваться практически любого задуманного вами эффекта.

Сегодня мы опять поговорим о тексте. Но текст тексту рознь. Кого привлечет блеклая надпись на афише или плакате? Совсем другое дело, если шрифты яркие и запоминающиеся. Все это легко реализовать при помощи PhotoShop. А рассказать сегодня я хочу о весьма сложных и интересных природных явлениях. Поговорим мы об огне и льде. Два несовместимых явления. Каждое из них испокон веков привлекало и пугало. Человек пытался приручить эти стихии, надо отметить, что частично ему это удалось. Попытаемся и мы укротить их, заставив принимать необходимые нам формы букв либо других символов и объектов.

Начнем, пожалуй, с огня.

Огонь 1 

Создадим заготовку произвольного размера в черно-белом цветовом режиме. Фон на вашем формате должен быть белым.
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Напишите ваш текст черным цветом. Если сразу вы не угадали нужный размер шрифта или место расположения надписи, то не огорчайтесь и не спешите все стирать и создавать текст заново. Все эти упущения вы можете исправить, нажав клавиши "Ctrl+Т". Вы сможете изменить размер ваших букв, место расположение надписи, а также ее наклон. После того, как вы выполнили все эти операции, откройте палитру "Слои". Там, указав мышью на букву "Т" на том слое, где расположен ваш текст, щелкните правой клавишею и из раскрывшегося списка выберите "рендеринг слоя " либо "отрисовать слой". Ваш выбор определяет перевод используемой вами версии. Теперь нам необходимо склеить слой с нашим текстом и слой фона. Вы можете это сделать, проделав следующие операции: "Слой -> Склеить слои", либо нажав клавиши Ctrl+E.

На следующем этапе вам надо кристаллизовать полученный текст, хотя эту операцию можно и пропустить. Но все же если вы решили ее сделать, то вам необходимо проделать: "Фильтр -> Оформление -> Кристаллизация".

Далее размойте ваше изображение с радиусом по гауссу приблизительно равным 1. Радиус зависит от размера вашего изображения и от выбранного вами шрифта. Чем больше и толще буквы, тем большим должен быть радиус. Для размытия вам нужно сделать следующее: "Фильтр -> Размыть -> Гаусс-размытие".

Инвертируйте ваше изображение, нажав клавиши Ctrl+I либо "Изображение -> Настройка -> Инвертировать".

Затем переверните изображение на 90 градусов против часовой стрелки (Изображение-> Повернуть холст-> 90гр. по ч.с.). Этот шаг необходим для того, чтобы на следующем этапе использовать фильтр "ветер", а он имеет только 2 направления и не может быть направлен вверх либо вниз.

Итак, создадим язычки пламени, хотя пока и в черно-белом варианте (Фильтр -> Стиль-> Ветер). Используйте настройки: Ветер слева. Если вам кажется, что пламя недостаточно большое, то примените этот фильтр снова, либо нажмите клавиши Ctrl+F. В моем случае я использовала "ветер" 2 раза.

Для большей реалистичности добавим небольшое пошатывание в наше пламя. А сделаем мы это следующим образом: "Фильтр -> Искажение -> Рябь". Опции были настроены так, что количество равнялось 50, а сила была установлена на среднее значение.

Теперь поставим наше пламя на ноги (Изображение -> Вращать холст -> 90 гр. по ч.с.).

Ну что, уже похоже? Применим еще раз "Фильтр -> Искажение -> Рябь". Только теперь количество установим на 30, а силу поставим высокую. По-моему, получается довольно неплохо.

Осталось добавить маленький штрих - раскрасить наше пламя. Сделаем мы это следующим образом: "Изображение -> Режим -> Индексированные цвета. Изображение -> Режим -> Цветовая таблица". Там выберете Black Body.

Ну, как вам результат? По-моему, впечатляет. Но не будем останавливаться на достигнутом и попытаемся создать еще одно пламя, которое будет несколько отличаться по своему стилю от предыдущего. Тут уже будет легче, так как создание второго огня будет весьма похоже на создание первого.

Огонь 2

Итак, приступим. Создаем вновь заготовку произвольного формата. Цветовая модель нашего изображения, как и в первый раз, будет черно-белой, а вот исходный фон - черный.

Напишите ваш текст. В палитре слоев щелкните правой клавишей мыши по букве Т и выберете "рендеринг слоя", либо "отрисовать слой". Теперь объедините фон со слоем, на котором написан текст, нажав клавиши Ctrl+E, либо Слой -> Склеить слой.

Поверните ваше изображение на 90 гр. ч. с. Причина необходимости этого шага аналогична причине его использования в первом случае.

Воспользуйтесь фильтром "ветер" (Фильтр -> Стиль -> Ветер). Настройки используйте следующее: Ветер справа. Проделайте эту операцию 2 раза, либо после первой нажмите сочетание клавиш Ctrl+F.

Теперь примените фильтр "диффузия" (Фильтр -> Стиль -> Диффузия). Настройку установите на значение "нормальная".

Теперь переверните ваше изображение в исходное положение (Изображение -> Вращать холст -> 90 гр. пр. ч. с.).

Размойте ваш текст (Фильтр -> Размытие -> Размытие по гауссу). Я использовала величину гаусс-размытия равную 2, но вы можете экспериментировать и наблюдать, как пламя меняется буквально на глазах.

Сейчас нам следует немного оживить пламя, заставить его колыхаться. Для этого воспользуемся фильтром "рябь" (Фильтр -> Искажение-> Рябь). Я использовала средний размер ряби, а количество равное 72. Сколько будете использовать вы, решать вам самим.

Ну, а теперь, самое интересное, будем разукрашивать наше пламя. Для начала переведем изображение в режим индексированных цветов. Для этого сделаем следующее: "Изображение -> Режим -> Индексированные цвета". И, наконец, самый последний шаг: "Изображение -> Режим -> Цветовые таблицы". Как и в предыдущем случае выберете таблицу Black Body.

Может случиться такое, что вместо огня вы получите нечто непонятное. Итак, если у вас какая-то путаница с цветами, то значит вы с самого начала создали и работали со своим изображением в цветовом режиме RGB, Lab либо CMYK. Не волнуйтесь, ничего страшного. Вернитесь на 2 пункта назад и перед переходом в индексированные цвета просто переведите свое изображение в черно-белый режим. Сделать это очень просто: "Изображение -> Режим -> Черно-белый". Вот и все. А затем проделайте все вышеперечисленные оставшиеся пункты, а именно: переведите ваше изображение в индексированные цвета и затем измените цветовую таблицу на Black Body.

Вот и все. Не правда ли, довольно просто, но зато как эффектно. Ни один человек не пройдет мимо, не заинтересовавшись содержанием столь привлекательной надписи.

Я надеюсь, что вы достаточно согрелись от созданного вами же огня, так как теперь у нас наступают суровые зимние морозы. Наш текст замерзнет и заискрится на солнышке.

Итак. Приступим.

Лед
Создайте заготовку произвольного формата в режиме градации серого. Цвет фона должен быть белым, а цвет переднего плана черным.
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Напишите текст. Я рекомендовала бы выбрать шрифт помассивнее. В итоге смотреться будет лучше и более впечатляюще. Открываем палитру "Слои" и щелкаем правой клавишей мыши по букве Т. Выбираем "отрисовать слой", либо "рендеринг слоя".

А сейчас мы начнем превращать эту невзрачную надпись в искрящийся лед. Для начала сделайте следующее: "Фильтр -> Оформление -> Кристаллизация". Установите значение кристаллизации равное 10. Однако на этом, простом казалось бы этапе и могут возникнуть проблемы. Дело в том, что в незарегистрированных версиях программы именно этот фильтр зачастую и не работает. Не расстраивайтесь, все поправимо. Попробуйте воссоздать результат при помощи обычных кистей и аэрографа. Если вы читали прошлую статью или владеете режимом быстрой маски, то я советовала бы воспользоваться именно этим методом, что бы восполнить недостатки вашей программы. Итак, если получилось, то здорово. Значит пора переходить к следующему этапу.

Сейчас добавьте немного шума (Фильтр -> Шум -> Добавить шум). Используйте значение 70 Gaussian.

Теперь слегка размоем наш будущий лед (Фильтр -> Размытие -> Гаусс размытие). Я рекомендовала бы использовать значение примерно равное 2.0.

А вот сейчас вам предстоит сделать выбор, так как вы можете воспользоваться одним из двух нижеперечисленных способов. Я пользовалась способом с кривыми.

1. Наиболее простой, но менее эффектный способ. Фильтр -> Размытие -> Размытие.

Теперь вам необходимо склеить слои. На одном слое находится наша надпись, на другом - фон. Для того чтобы совместить слои, вы можете нажать сочетание клавиш Ctrl+E, либо выполнить операции "Слой -> Слияние слоев".

Сейчас следует инвертировать наше изображение. Для этого и понадобилось слияние слоев, так как последующие преобразования будут касаться не только текста, но и фона, на котором он находится. Выполните: "Изображение -> Настройки -> Инвертировать", либо просто нажмите клавиши Ctrl+I.

2. Этот способ более кропотливый, но зато эффект получается намного лучше. Изображение -> Настройка -> Кривые, либо сочетание клавиш Ctrl+M.

Тут следует рассказать вам, что же такое кривые и зачем они предназначены, чтобы вы не передвигали бессознательно различные установки, не добившись желаемого результата. Итак, кривые - это инструмент для коррекции цвета, причем, если вы работаете в различных цветовых моделях, то вы можете редактировать различные их каналы независимо друг от друга. Вы можете видеть две шкалы (вертикальную и горизонтальную), указывающие на выходные и входные уровни соответственно. Данная кривая как раз и отображает взаимосвязь между этими уровнями. Направление изменения значения яркости указывает горизонтальная черно-белая шкала. Однако если вам неудобно работать с тем направлением, которое установлено по умолчанию, то вы можете щелкнуть по ней левой клавишей мыши, и белая и черная части шкалы поменяются местами.

Попытайтесь создать кривую похожую на ту, которая изображена на рисунке. Хотя, если вас что-то не устраивает в получившемся варианте, вы можете сами поэкспериментировать с кривыми. 

Ну, а теперь, необходимо выполнить те же операции, что и в первом варианте, а именно: склеить слои и инвертировать изображение, нажатием Ctrl+E, Ctrl+I соответственно.
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После того, как вы определились, какой вариант вам больше нравится, и выполнили его, переходим к следующему этапу.

Какой лед может быть без сосулек? Именно их созданием мы сейчас и займемся. "Изображение -> Вращать холст -> 90 гр. по. ч. с. Фильтр -> Стиль ->Ветер". Настройки используйте: Ветер слева. Теперь перевернем холст в исходное положение (Изображение -> Вращать холст -> 90 гр. пр. ч. с.).

Теперь стоит придать немного голубизны нашему льду. Для этого переведите свое изображение в цветовой режим RGB (Изображение -> Режим -> RGB. Затем Изображение -> Настройка -> Цвет / Насыщение, либо Ctrl+U). Установите флажок в графе цвет и поэкспериментируйте с различными настройками тона, насыщенности и легкости. Когда вы добьетесь понравившегося вам результата, то нажмите ОК.

Ну, а напоследок, чтобы ваш лед засверкал и заискрился, выберете инструмент "аэрограф", установите значение pressure примерно на 20-30 и, щелкнув по треугольнику возле палитры кистей, загрузите дополнительные кисти. Воспользуйтесь некоторыми из них для создания эффекта искрящегося и переливающегося на солнышке льда.

Я надеюсь, что вас заинтересовали эти эффекты. Они довольно просты и незамысловаты при создании, но зато весьма и весьма эффектны в итоге. Как вы смогли убедиться, PhotoShop не уступает трехмерной графике при создании некоторых спецэффектов, хотя потрудиться приходится несколько дольше.
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	Все новое это хорошо забытое старое. Пословица эта несомненна и вполне всеобъемлюща. Исключение не составляет и работа с Adobe PhotoShop. Особенно в следующем:
подавляющее большинство дополнительных плагинов не приносят нам ничего нового, они просто упрощают процедуру создания эффектов. Как правило, от этого и рождается впечатление новых, неиспользованных возможностей — то, что мы раньше не могли сделать либо по незнанию, либо по недостаточной ровности рук, теперь лежит перед пользователями, как говаривал Великий Комбинатор, на блюдечке с голубой каемочкой. Я не спорю, что это удобно и со всех сторон положительно. Я даже не придерживаюсь мнения некоторых пользователей, которые считают, что использование дополнительных плагинов ухудшает способности пользователя (хотя такой момент, несомненно, есть — чутье теряется). Но я хочу сказать, что нет ничего, что невозможно сделать стандартными средствами Adobe PhotoShop. Хотя бы в том плане, что работаем мы с растровой графикой — и в крайнем случае можно нарисовать по точкам :). Большинство дополнительных модулей так или иначе используют возможности Adobe PhotoShop, как правило, обращаясь к его библиотекам. Некоторые вообще в принципе являются замаскированными экшенами (actions). Первая часть этой статьи как раз и будет посвящена доказательству всего вышесказанного.
Я уже несколько раз в этой серии касалась вопроса создания "загнутого уголка" в изображении. Но рассказывалось об этом только в свете дополнительных плагинов, а конкретно AV broth. Page curl и KPT 3.0. В принципе они, особенно первый, хорошо справились со своей задачей. Но мне читатели задают вполне резонный вопрос: а возможно ли реализовать этот эффект без всяких программ. Конечно, можно. Даже с тем же качеством. Но, конечно, не так быстро и просто, хотя это тоже не займет у вас много времени. Приведенный пример — самое простое, что можно сделать. Всякие навороты, вроде прозрачности, реализовать тоже не представляет труда, но чтобы сделать это реалистично, придется посидеть несколько дольше. Создание по описанию, которое идет ниже, займет несколько минут.

"Завернутый уголок" руками
Прежде всего, необходимо выбрать фотографию. Самый простой вариант — моно-цветная заливка. Однако, это имеет мало практического смысла, так как чаще всего редактируемые изображения реальные фотографии. Но, в принципе, можно работать с любым изображением. У меня на примере есть элемент, который облегчает задачу — он к низу переходит в моно-заливку. Но это совсем необязательно.
Сегодня впервые в этой серии мы коснемся инструментов серии "Перо". Люди, которые работают с векторной графикой, отлично знают этот инструмент — им рисуется почти все в Adobe Illustrator и Corel. Инструмент этот и в Photoshop я лично считаю незаменимым.
Постараемся осознать, что такое "Перо" и создаваемые им пути. Сразу вы будете воспринимать их как линии, однако это неправильно. Путь не есть нарисованная линия. Путь гораздо ближе к выделению, так как мы можем изменять его, превращать в выделение непосредственно, заливать область, ограниченную путем, превращать путь в линию. Как все это делать?
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Для работы необходимо знание двух областей — разных перьев в основном меню и палитры "Пути". Если она у вас не открыта, то сделайте это. Начнем рассмотрение с перьев.
1. "Перо". Выглядит как перьевая ручка. Основной инструмент в работе с путями и самый старый из всех. Пользоваться им несложно, но необходима некоторая практика. Для того чтобы вычертить прямую линию, просто щелкните по картинке первый раз в начале будущей линии, а второй — в конце. Если щелкнуть и не отпустить, то будут создаваться закругленные отрезки. Как именно они создаются, вы поймете сами, попробовав.
2. "Магнитное перо". Действует примерно так же, как "Магнитное лассо". То есть, выделение будет производиться по цветовой грани. Этот инструмент применяется в том случае, если вы хотите, например, редактировать контур автомобиля.
3. "Свободное перо". Очень полезный инструмент, особенно тогда, когда у вас есть дигитайзер или очень ровные руки. Примерно то же самое, что и "Лассо", но создает путь, а не выделение. Для тех, кто не помнит, что такое лассо, — этот инструмент создает выделение ровно так, как вы проводите курсором. Применяется, как правило, в сочетании со следующим инструментом.
4. "Добавить опорную точку якоря". Мой любимый путевой инструмент. Позволяет добавлять точки и их редактировать — изменять положение и путь соответственно. Он понадобится нам сегодня.
5. "Удалить опорную точку якоря". Удаляет точки на пути. Кроме того, при наведении на пустую область линии пути позволяет ее смещать.
6. "Прямое выделение". Один из самых старых инструментов — был еще в третьей версии. Трансформирует имеющийся путь без изменения количества точек. Удобен именно в этом случае.
7. "Преобразование точки". Этот инструмент преобразует любую точку в точку скругления. То есть, это идеальный инструмент для того, чтобы превратить прямую в кривую.
Рассмотрение инструментов закончено. Перейдем к панельке "Пути".
Как вы, наверное, уже обратили внимание, эта панель очень похожа на "слои". Во-первых, используя кнопку "Создать новый путь", можете иметь у себя на изображении не один, а необходимое их количество. Имеет значение и порядок их размещения. Также на этой панели есть:
1) Заливка пути текущим цветом (черный кружок). Применяется при создании геометрических форм.
2) Обведение пути текущим цветом (белый кружок).
3) Преобразование пути в выделение (штриховой кружок). Очень полезный инструмент, на мой взгляд, наиболее часто применимый.
4) Удалить путь.
Теперь, когда теоретическая часть закончена (я вообще стараюсь избегать описания инструментов в этой серии, но, как правило, пользователи не умеют применять пути), можно перейти непосредственно к созданию уголка.
Посмотрите на иллюстрацию. Под пунктом "1" отображен путь, который вам необходимо создать. Делается это проще простого. Для начала вам потребуется инструмент "перо". Первую точку закрепите в нижнем левом углу изображения, вторую — на правой стороне, на примерной высоте начала сворота, третью — в его вершине. В результате вы получите треугольник. Правую его сторону теперь необходимо закруглить так, как это показано на иллюстрации. Для этого стоит использовать инструмент "Добавить опорную точку якоря". Создайте точку в центре отрезка и вытяните внутрь. Результат должен быть похож на тот, который изображен на рис. 1. Затем преобразуем путь в выделение.
Теперь перейдем к следующему этапу работы. Нам необходим инструмент "градиент". Откройте его и при помощи панели "параметры" создайте новый градиент, похожий на тот, что изображен у нас на иллюстрации "2". Затем наложите его в виде "линейный градиент" на выделение. Не забудьте стереть тот угол изображения, который вы как бы загнули. Ну вот, почти вся работа сделана. Для пущего реализма можно применить к слою, на котором находится уголок, стандартный эффект "тень". Результат работы на иллюстрации 3.
Следующий эффект, который хотелось бы представить вашему вниманию, создается при помощи фильтра 3D transform. Хотя PhotoShop и является двухмерным графическим редактором, но в нем все же возможна реализация примитивных трехмерных объектов.
Стоит отметить, что 3D трансформ не является единственным фильтром, позволяющим обрабатывать трехмерные объекты в PhotoShop. Еще до того, как компания Adobe изобрела данный инструмент, был создан другой, который назывался Series 2: 3D filter, выпущенный Andromeda ( www.andromeda.ru ), а также после него был создан еще целый ряд дополнительных фильтров с наиболее проработанным интерфейсом, предоставляющих множество новых возможностей.
Я хочу предложить вам убедиться на простом примере, что реализация трехмерных объектов в PhotoShop благодаря фильтру 3D transform превращается в довольно увлекательное и простое занятие.
Сперва несколько слов о данном фильтре. Находится он в разделе "Рендер". После того, как вы примените данный фильтр, откроется диалоговое окно, состоящее из области предварительного просмотра, палитры инструментов и области управления камерой.
Всего в данной программе существует 12 инструментов. Из них три простые формы: куб (М), сфера (N), цилиндр (C) (в скобках указаны клавиши, при помощи которых вы можете выбрать данный инструмент с клавиатуры). В PhotoShop 6.0 примитивов значительно больше.
Два инструмента редактирования: выделение (V) — черная и непосредственное выделение (А) — белая стрелочка. При помощи инструмента "Выделение" вы можете перетаскивать ваш объект по области предварительного просмотра, а при помощи "Непосредственного выделения" — редактировать его форму. Между данными инструментами можно переключаться при помощи сочетания клавиш Ctrl+Tab.
Далее располагаются еще три инструмента редактирования, использование которых возможно только с цилиндром. Это инструменты: Вставить точку (+) — перо с плюсом, убрать точку (-) — перо с минусом, конвертировать точку — уголок. Действие первых двух инструментов понятно, а вот третий инструмент придает точке вид острого угла, при повторном применении данного инструмента изгиб вновь становится плавным.
Далее идут два инструмента, которые и объясняют название данного фильтра, а именно 3D трансформ. Итак, это "Панорамная камера" (Е) — круг с четырьмя стрелками. При использовании данного инструмента вы как бы двигаете камеру, при помощи которой наблюдаете за объектом, т.е. если вы переместите изображение влево, то сможете получше увидеть его правый бок. Второй инструмент трекбол (R) — круг с одной стрелкой. При помощи данного инструмента вы вращаете объект в пространстве.
Оставшиеся инструменты рука (Н) и масштабирование (Z) работают аналогично таким же инструментам, находящимся в основной палитре PhotoShop.
После того, как вы вкратце ознакомились с данным фильтром и уловили принцип его работы, можно перейти к непосредственному созданию рисунка. Откройте новое изображение и напишите на нем что-нибудь, только ваша надпись должна быть не очень больших размеров, а то вам придется столкнуться с кое-какими трудностями в последующем. После написания текста вы можете его слегка подредактировать, нажав сочетание клавиш Ctrl+T. После того, как вы добьетесь желаемого результата, вам следует отрисовать слой с текстом, для этого сделайте следующее: щелкните правой клавишей мыши по данному слою и из раскрывшегося меню выберите "Рендеринг слоя".
Сейчас приступим к непосредственной работе с фильтром 3D. Для это проделайте операции: Фильтр — Рендер — 3D transform. В данной статье будет описан пример работы с наиболее простым объектом, а именно со сферой, однако вы можете выбрать и более сложные и интересные фигуры.
Итак, после того, как вы открыли диалоговое окно фильтра, вам необходимо выбрать инструмент "Сфера" и создать выделение вокруг вашей надписи, не забывайте, что у вас есть инструменты редактирования, а также возможность управлять камерой. В итоге ваш круг должен полностью опоясывать надпись и умещаться на изображении целиком. Теперь возьмите инструмент "Трекбол" и попробуйте повернуть сферу. Вы можете вращать ее во всех направлениях. Вам необходимо развернуть ее так, чтобы буквы немного исказились, но были видны полностью.
После того как вы нажмете клавишу ОК, у вас должно получиться нечто похожее на изображение 1.
Создайте новый слой и назовите его "Сфера". На этом слое сделайте круглое выделение при помощи стандартного инструмента PhotoShop "Элиптическое выделение". Для того чтобы выделенная область имела форму круга, применяйте данный инструмент при нажатой клавише Shift. Расположите его так, чтобы оно совпадало с кругом, образованным фильтром 3D transform.
Затем создайте градиентную заливку от черного к белому цвету при помощи инструмента "Радиальный градиент". Светлая часть градиента должна располагаться ближе к центру, а черная — по периметру. Для того чтобы шар не заслонял надпись, поменяйте слой с текстом и слой с градиентом местами при помощи простого перетаскивания.
Сейчас возьмите инструмент "Ластик", небольшую кисть и на слое с текстом сотрите серые участки сферы, которые появились при применении фильтра 3D.

Теперь попытаемся создать эффект нависающего текста над шаром. Что для этого необходимо? Прежде всего, конечно, тень от букв. Для ее создания вы можете воспользоваться каким-либо дополнительным фильтром, а можете и эффектами слоя. Для этого сделайте активным слой с текстом и, проделав следующее: Слой — Эффекты — Отбросить тень, подберите настройки, подходящие к вашему изображению. Я использовала такие параметры: непрозрачность — 70 процентов, угол — 114 градусов, дистанция — 17 пикселей, размытие — 1, интенсивность 60%. Если не довольны получившейся тенью, то можете отменить действие либо слегка подредактировать ее, нажав сочетание клавиш Ctrl+T.
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Если вы проделали все вышеописанные операции правильно, то у вас должно получиться изображение похожее на то, которое представлено вашему вниманию на рисунке 2.
И, наконец, приступим к заключительному этапу в создании данного изображения, а именно к приданию объема буквам и цвета шару.
Для того чтобы осуществить первый пункт, вам необходимо сделать активным слой с текстом и еще раз воспользоваться эффектами слоя, а именно "Слой — Эффекты — Скосы и Рельеф". Здесь вы можете поэкспериментировать с настройками, однако ниже приведен пример тех параметров, которые были использованы при создании изображения представленного вашему вниманию. Блики: Mode — экран, непрозрачность — 100%; Тень: Mode — Умножить, прозрачность — 75%; Style — Inner Bevel, угол — 48, глубина — 14 пикселей, размытие — 15, направление — вверх.
После того, как работа над буквами завершена, следует разукрасить шар, наиболее простой способ сделать это — воспользоваться таким параметром, как "Цвет, Насыщение". Данная опция находится в раскрывающемся меню Изображение — Коррекция. Работая с данными настройками, не забудьте установить флажок возле указателя цвет.
Ну а напоследок, чтобы создать еще большую иллюзию объема, можете добавить тень от шара, аналогичным способом тому, как создавали тень от букв, только на этот раз активным должен быть слой "Сфера".

Xenofex от Alien Skin
Я уже писала про набор плагинов Eye Candy 3.0 того же производителя. Как вы, наверное, обратили внимание — это, несомненно, один из лучших представителей своего жанра. Кстати, уже вышел Eye Candy 4.0, который получил приз как лучшая программа под Adobe Photoshop. В принципе, так оно и есть. Я опишу подробно его в следующей статье. Сегодня же мы рассмотрим вторую (по сути) часть Eye Candy, которая называется Xenofex. 

Почему я так ее обозвала? Потому что она ну очень похож на Eye Candy 3.0 — тот же интерфейс, те же параметры во многих фильтрах и так далее. Почему компания создала два набора по 16 фильтров, а не один набор в 32? Причина чисто коммерческая — лучше продать две программы по 109 долларов, чем одну по той же цене. Именно по той же, так как никто больше ста не заплатит — такая уж конъюнктура рынка. Итак, что такое Xenofex? Вот что о нем пишет создатель:
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"Xenofex — это коллекция из 16-и вдохновенных специальных эффектов, которые придадут новую энергию любому графическому проекту. Еще никогда нельзя было так легко создавать натуральные эффекты и сложные искажения. Интерфейс прост и интуитивен, он включает в себя полностью масштабируемое окно предпросмотра, которое позволяет вам видеть накладываемый эффект для любой части вашего изображения. Xenofex также включает в себя 160 предустановленных настроек, которые помогут вам быстро создавать сложные эффекты".
Примерно так оно и есть. Интерфейс, как было сказано, такой же, как в Eye Candy, то есть просто замечательный. Особенно радует наличие уймы готовых вариантов настроек — всегда можно найти что-нибудь подходящее. Ну, перейдем к рассмотрению непосредственно фильтров.
Baked Earth — очень хороший эффект, практически не имеющий аналогий у других производителей. Позволяет создавать впечатление растрескавшейся земли. Весьма эстетично на вид, а куча настроек позволяет делать очень многое — от горной породы до стеклянной мозаики.
Constellation — это описать достаточно сложно. Фильтр с множеством калейдоскопических эффектов (эффектов света). Примерно делает следующее: делит изображение на некоторое количество областей, которые преобразует в светящиеся точки, цветом похожие на цвет исходной области.
Crumple — создает впечатление помятой бумаги. Делает это, кстати, замечательно. Я, может, в будущем, опишу, как сделать это стандартными средствами. А пока это — лучший вариант. Можно создавать очень многое — от пергамента до вспаханного поля. Очень советую.
Distress — хм... Интересный такой эффект, будто ваше изображение кто-то пожевал. Причем параметры есть все необходимые. Идеальный фильтр, дабы создавать впечатление рваной бумажки или погрызенных букв. Советую.
Flag — не скрою, этот фильтр меня очень поразил, когда я впервые его увидела. Ничего подобного в двухмерной графике (на мой взгляд) нет. Позволяет создавать впечатление развевающейся на ветру ткани. Идеально для создания флагов. На это у вас уйдет всего пару минут. Можете, так же нарисовать белье на просушке. Да, скоро я опишу, как создать анимированный флаг на ветру стандартными средствами.
Lighthing — самый впечатляющий и любимый массами эффект в этом наборе. Можно поиграть в Зевса, в смысле, создать молнию. Причем великолепную, очень реалистичную молнию! Опять же, громаднейшее количество настроек, которые позволяют делать просто фантастические вещи.
Little Fluffy Clouds — будем создавать облака. Отличнейшие такие облака, очень широкого диапазона — от едва заметного тумана до штормового неба. Все необходимые настройки, как, впрочем, и везде. В сочетании с молнией выглядит очень эффектно. А если с помощью разбитой земли пустыню создать, то готов пейзаж.
Origami — интересный искривляющий фильтр. Делит изображение на маленькие треугольники и поворачивает их вокруг оси. Можно делать достаточно интересные изображения.
Puzzle — как вы, наверное, уже поняли, это обычная мозаика. В общем, ничего такой эффект. Но я вскоре в серии напишу, как стандартными средствами создать более приятную визуально мозаику.
Rounded Rectangle — создает в выделенной области прямоугольник с закругленными краями. Правда, прямоугольник можно сделать эллипсом через параметры закругления. Этот фильтр идеально подходит для создания кнопок, рамок и так далее. Правда, на мой взгляд, значительно уступает Photobutton из PhotoTools.
Shatter — оригинальный и очень красивый эффект. Создает впечатление, что вы смотрите на свое изображение из разбитого зеркала. Имеется необходимое количество настроек. Мне лично этот фильтр весьма импонирует.
ShowerDoor — как следует из названия, создает впечатление взгляда на изображение сквозь кабинку душа (то есть такое рельефное стекло). На мой взгляд, ничего интересного, но иногда может пригодиться.
Stain — такого вы больше нигде не увидите. Этот фильтр позволяет создавать впечатление грязного пятна. Идеально, чтобы посадить пятно от кофе на чистую блузку. Как это ни странно, но такое весьма часто необходимо имитировать. Одним словом, хороший фильтр.
Stamper — просто мозаичный фильтр. Описать это я не могу, посмотрите сами.
Television — полезный фильтр. Позволяет имитировать разные экранные эффекты. От разверстки старых телевизоров до светотеневых переходов при наведении камеры на современный высокочастотный дисплей. На мой взгляд, полезный фильтр.
Ну, вот и все. Описание закончено. Выкачать его из Интернет можно с http://fosi.da.ru, весит он совсем немного — 640 килобайт, 4 минуты модемной скачки. Кстати, на том же сайте вы можете взять и Eye candy 4.0 — он будет описан в следующей статье.
На сим позвольте распрощаться. Удачи.
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За последнее время я получила много писем с просьбой подробнее остановиться на нововведениях, которые появились в шестой версии данной программы, и рассказать о новых эффектах, реализованных при использовании именно этой версии. Не оставив без внимания просьбы читателей и учитывая появление новых возможностей, начиная с данной статьи, говорить мы будем о программе Adobe PhotoShop 6.0.
Первое нововведение — это появление автофигур. Раньше, чтобы нарисовать примитивный объект, необходимо было долго возиться с инструментами выделение, заливать их необходимым цветом, а то и того хуже — рисовать его при помощи кисточки, карандаша или аэрографа. Еще, конечно, можно было воспользоваться пером, но тут тоже возникали проблемы, особенно для тех, кто раньше не работал с векторной графикой. Теперь все стало значительно проще. Необходимо выбрать фигуру, похожую на ту, которую вы желаете получить, и потом лишь слегка отредактировать ее. Тут есть один нюанс. После того, как применен данный инструмент, создается новый слой, и именно на нем реализовывается объект. После этого можно исправлять его форму, но нельзя применять к нему никаких инструментов рисования, фильтров и много другого. Дело все в том, что данные фигуры представляют собой элемент векторной графики, и подобно шрифтам не являются растровым изображением. Чтобы это исправить, достаточно щелкнуть правой клавишею мыши по необходимому слою и из раскрывшегося меню выбрать опцию "Rasterize Layer" (Рендеринг слоя).
Следующая новинка — это появление такого инструмента, как Styles (Стиль), который чем-то похож на текстуры, но имеет некоторые принципиальные отличия. Применяется данный инструмент к любому слою, кроме фонового. Особенность его состоит в том, что используется он не только на всем формате, но и применим к отдельным объектам и автофигурам. Стили представляют собой готовые фоновые изображения, среди которых можно выбрать что-нибудь подходящее для своего изображения. Здесь есть очень много вариантов, начиная от простых градиентов и заканчивая текстурами реальных материалов и фантастическими узорами. Палитра данного инструмента входит в состав основных. Если окно "Стиль" скрыто, то открыть его можно, проделав следующее: Window –> Show Styles (Окно –> Показать Стили).
Непосредственно на самой панели находятся клавиши, позволяющие реализовывать три действия: очищать палитру (круг, перечеркнутый линией), создавать новый стиль (чистый лист) и удалять имеющийся (корзина).
Чтобы открыть дополнительные функции, необходимо щелкнуть по черному треугольнику, расположенному в верхнем правом углу палитры.
Первые два раздела похожи на стандартные, а именно те, которые есть практически во всех других палитрах.
New Styles (новый стиль). Выбор данной опции позволяет добавлять свой образец в палитру.
Reset Styles (перегрузить стили). Устанавливает набор стилей по умолчанию.
Load Styles (добавить стиль). Добавляет новый набор к уже загруженным.
Save Styles (сохранит стиль). Применяется при создании собственной палитры, которую впоследствии можно сохранить при помощи данной функции.
Replace Styles (заменить стиль). Заменяет текущие на новые.
В третьем — можно выбрать форму, в которой будут представлены образцы:
Text Only — Только Текст.
Small Thumbnail — Маленькие иконки.
Large Thumbnail — Большие иконки.
Small List — Маленький список.
Large list — Большой список.
В последнем разделе можно выбрать уже один из готовых наборов стилей, названия которых дают представление об оптимальной сфере использования.
После того как с основными функциями стало все понятно, следует разобраться, что же представляют из себя эти пресловутые стили и как их применять.
Начнем с основного. Как они работают? Создайте новое изображение с не менее чем двумя слоями. Сделайте активным слой выше первого и щелкните по любому стилю. В результате вы получите очень интересный эффект.
Теперь, что такое стили? Чтобы ответить на этот вопрос, откройте палитру Layers (Слои) после применения одного из них. Любой стиль это есть просто комбинация базовых слоевых эффектов. В этом можно еще раз убедиться, если дважды кликнуть мышкой по любому из показанных эффектов. Откроется стандартное окно настроек для данного стиля.
Вы также можете создавать собственные Styles. Для этого достаточно сгруппировать некоторые базовые эффекты и нажать кнопку "New" в палитре Styles.
Как вы могли убедиться, стили — это огромная помощь при работе с PhotoShop. Однако не стоит злоупотреблять ими в том смысле, что хорошо владеть работой только с ними, забывая остальные возможности PhotoShop 6.0.
В следующих статьях я подробнее остановлюсь и на других возможностях шестой версии программы. Здесь имеется в виду работа с текстом, новые слоевые эффекты и многое другое.
Возвращаясь непосредственно к теме цикла данных статей, вновь (как и было обещано ранее) поговорим о тексте. Сегодня я предлагаю вам еще один вариант того, как из простого текста можно создать интересную, а главное оригинальную надпись.

"Болотный" текст
Название данного эффекта говорит само за себя. Предлагаю попробовать создать нечто слизкое, водное, противное, в общем, как в американских фильмах ужасов всякую нечисть изображают. И действительно, что-то мы всякие приятные вещи рисуем, а ничего неприятного на вид не описали. А ведь это приходится применять даже чаще, чем многое из того, что описано в предыдущих статьях. Хотя, открою одну особенность данного спецэффекта, итоговый результат будет зависеть во многом от того цвета, который будет применен при создании изображения. То есть если вы выберите приятные зеленовато-изумрудный цвет, то, к сожалению, а может быть и к радости, ничего противного у вас не получится.
Итак, приступим непосредственно к работе. Какого цвета должно быть что-то очень неприятное на вид? Правильно, зеленого (болотного). Именно этот цвет ассоциируется у большинства людей с чем-то неприятным. Это известно очень давно, и поэтому в рекламе продуктов почти никогда нет зеленого цвета.
Итак, создаем новый файл и заливаем его зеленой краской. Лучше взять ее скорее темно-зеленой, чем салатовой — эффектней будет результат.
Итак, прежде всего, добавьте шум на исходное изображение. Сделать это можно при помощи фильтра Noise: Filter –> Noise –>Add Noise (Фильтр –>Шум –>Добавить Шум). Сила действия должна быть порядка 20-30.
Теперь на время оставим текстуру и перейдем к созданию заготовки для букв.
Необходимо открыть новый канал. Для этого достаточно кликнуть мышкой по кнопке "Create a new channel" (Создать новый канал) (чистый лист), расположенной в нижней части палитры каналов (Channels).
Используя инструмент "Text", напишите любое слово в новом канале. Лучше не выбирать слишком массивный или тонкий шрифт, так как в первом случае эффект будет очень грубым, а во втором — либо плохо видным, либо слишком ярко выраженным (зависит от настроек).
После выполнения последней операции можно вернуться в RGB канал и продолжить редактирование текстуры.
Для того чтобы придать ей специфический вид, воспользуемся фильтром Wind: Filter –>Stylize –>Wind (Фильтр –>Стилизация –>Ветер).
Исходную текстуру можно считать готовой. Если хотите, то примените фильтр "Ветер" вторично, возможно в вашем случае это улучшит ее вид.
Пришло время использовать заготовку в виде текста в канале. После применения следующего фильтра он проступит в канале RGB, кроме того, будет выглядеть достаточно объемным и с наложенной текстурой. Запустите фильтр Эффекты света: Filter –>Render –>Lighting Effects (Фильтр –>Рендер –>Эффекты света).
Обратите внимание на самый главный параметр — в качестве Texture Channel (Канал текстуры) мы использовали канал Alpha 1, на котором был написан текст.
Поверните полученное изображение на 90 градусов против часовой стрелки: Image –>Rotate Canvas –>90 CW (Изображение –>Вращать холст –>90 п.ч.ст.).
Примените фильтр Wind: Filter –>Stylize –>Wind (Фильтр –>Стилизация –>Ветер) для того, чтобы создать "водоросли" на тексте.
Полученные отростки напоминают намеченную цель очень и очень слабо. Для исправления этого лучше всего воспользоваться фильтром Ripple: Filter –>Distort –>Ripple.
После этого осталось вернуть изображение в нормальное состояние, то есть повернуть его в противоположную сторону и поставить буквы на ноги.
На этом работа сделана полностью. Если результат вас не вполне удовлетворяет, то, скорее всего, стоит его подкорректировать при помощи Brightness/Contrast: Image –> Adjust –> Brightness/Contrast (Изображение –> Настройка –> Яркость/Контраст). Итоговое изображение показано на рисунке. Сейчас, по сложившейся уже традиции, предлагаю вам описание еще одного творения компании, которая создает дополнительные плагины к Adobe PhotoShop, а именно фильтр KPT 5.0.

KPT 5.0 от Metacreation
В свое время самым известным дополнительным плагином был KPT 3.0. Он был своего рода стандартом, на который равнялись остальные производители программного обеспечения под PhotoShop. На сегодняшний день KPT 3.0 уже морально устарел. Однако, компания Metacreation не стояла на месте и выпустила еще два уникальных по своим возможностям набора плагинов — KPT 5.0 и KPT 6.0. Данный раздел в этой статье будет посвящен пятой версии программы.
Сразу стоит сказать, что пятая и шестая версии KPT не имеют ничего общего, и поэтому о шестой версии я расскажу в одной из следующих статей.
KPT 5.0 это один из лучших наборов плагинов, который в основном направлен на искажение изображения. Его нельзя назвать столь же полезным, как Eye Candy, но и области применения у этих программ совершенно разные. Eye Candy направлен прежде всего на прикладные цели, связанные в основном с web-дизайном. KPT 5.0 плагин скорее художественного назначения, область его применения ближе к полиграфии и искусству.
Так как дополнительные плагины мы рассматриваем исключительно обзорно, то на интерфейсе программы останавливаться не стану. Скажу только, что он достаточно удачен, но намного хуже, чем, к примеру, у Xenofex.
Перейдем к описанию входящих в данный набор плагинов.

Blurrrr
Да, именно так название и пишется, с четырьмя буквами "R". Причина, по какой создатели пакета не назвали его просто Blur (Размытие), не известна. Возможно, были проблемы с авторскими правами. Но это не имеет особого значения, так как Blurrrr это самый лучший фильтр, связанный с размытием, из всех существующих. Огромнейшее количество настроек, а следовательно и возможностей. Особенно радует то, что можно создавать впечатление фокусировки камеры, то есть, какой-то объект показывается четко, а все остальное немного размыто. Это всегда бывает в реальной фотографии, и поэтому данный фильтр незаменим в профессиональном фотомонтаже.

Noize
Великолепный фильтр. Как вы могли уже понять из названия, этот фильтр связан с созданием шума. Однако, на шуме возможности Noize не заканчиваются. При помощи него можно создавать мятую бумагу, воду, узоры на стекле, горную поверхность и многое, многое другое, главное понять принцип его работы, что совсем несложно. Учитывая то, как часто при работе с PhotoShop необходим шум, можно считать этот фильтр одним из лучших в наборе.

Radwarp
Фильтр, позволяющий имитировать целый спектр объектов, начиная от стеклянной линзы и заканчивая каплей воды. Достаточно удобен и продуман, но все же его нельзя считать лучшим в своем роде, в основном из-за интерфейса. Однако, если есть необходимость нарисовать очень правдоподобную линзу, никакого другого пути у вас нет (по крайней мере столь быстрого, эффектного и реалистичного). Также можно создавать оригинальные сюрреалистичные работы за несколько секунд.

Smoothie
Красивый и очень простой фильтр. Пожалуй, самый простой во всем наборе. Перерисовывает ваше изображение в битовых цветах. Можно добиться достаточно интересных эффектов, особенно если вам необходимо распечатать их без цвета. Описать это достаточно сложно, поэтому если заинтересовались, то посмотрите, попробуйте — и поймете.

Frax 4D
Самый оригинальный плагин в KPT 5.0. Ближе даже не к двухмерной, а трехмерной графике. По сути, это небольшая программа для генерации трехмерных тел вращения. Можно создавать различные тела через вращение плоскости, то есть конусы, цилиндры, шары и так далее. Но это еще не все. Если вы зададите сложный контур, то получите что-то очень странное, больше всего напоминающее страшно смятый кусок железа. Правда, если вы никогда не работали в программах трехмерной графики, то освоить этот плагин будет тяжело.

Fraxflame
Очень красивый эффект. При помощи его вы сможете создавать фантастические узоры, аналогичных которым нельзя увидеть больше нигде, поэтому и сравнить не с чем. Огромнейшее количество настроек и готовых вариантов делают Fraxflame незаменимым для многих фотохудожников, работающих в PhotoShop.

Flaxplorer
Все, что сказано про Flaxflame, можно повторить и по отношению к этому плагину. Внешне они сильно отличаются, но делают примерно одно и то же — фантастические узоры. При помощи данного фильтра за несколько секунд создаются великолепные работы, которые прекрасно смотрятся и сами по себе и в композиции. И, самое главное, их можно анимировать.

Fiberoptix
Оригинальный искажающий фильтр. Создает впечатление, как будто изображение состоит из сотен тонких, радиальных полос. Прост в применении и выглядит достаточно интересно, чем и может привлечь внимание.

Orb-it
Фильтр, создающий множество объемных шаров. Все необходимые настройки. Особенно радует возможность накладывать на шары собственные карты, то есть любое изображение, что позволяет рисовать действительно красивейшие изображения.
На этом обзор данного дополнительного плагина подошел к концу, а также заканчивается и статья. Если у вас есть вопросы либо предложения, то пишите.
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	Начиная изучать какой-либо вопрос, мы сперва обращаемся к теории, но для закрепления ранее рассмотренного нам не обойтись без практики. Для подтверждения данной мысли вспомним хотя бы школу. "Мы все учились понемногу чему-нибудь и как-нибудь... ", но далеко не все, что старательные учителя пытались вложить в наши бессознательные головы, мы помним и сейчас. Ну кто вспомнит химические и физические свойства ацетальдегида или имя правителя Персидской державы в период с 522 по 486 годы до нашей эры? Совсем иначе обстоит дело с вещами, которые мы применяли на практике либо воспроизводили многократно в процессе работы. Наверняка никто не забыл, сколько будет 2*2 или как забить гвоздь. Все сказанное ранее можно отнести практически к любому виду деятельности.
Графические редакторы, в том числе и PhotoShop, не исключение. Можно долго рассказывать о различных цветовых моделях, рекомендовать те либо иные настройки, но пока сам не проделаешь все эти операции, они остаются непонятными. Поэтому эту и другие мои статьи, посвященные PhotoShop, я рекомендовала бы читать перед компьютером, чтобы самому убедиться либо разубедиться в том, о чем я вам буду рассказывать. А поговорим мы сегодня о масках.
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Маска — это область выделения, представленная в полутоновом виде. Черные пикселы в маске соответствуют невыделенным областям, белые — выделенным, а серые — частично выделенным. PhotoShop дает нам возможности для создания двух типов масок. Первая — это быстрая маска. Она существует для однократного применения и не сохраняется, образует временный канал на период своего действия. Вторая — это просто маска, которую иногда еще называют альфа-каналом. Таких каналов одновременно может храниться довольно большое количество.
Преимущество маски в том, что она является независимым полутоновым изображением, то есть ее можно редактировать, не влияя при этом на основное изображение. При внесении в нее изменений можно использовать любые инструменты рисования и редактирования, любые фильтры, любые параметры при световой и цветовой коррекции.
Как вы уже знаете, PhotoShop — это графический редактор, предназначенный для создания и редактирования растровых изображений. Любой объект в растровой графике представлен в виде множества точек. Для того чтобы совершить какую-либо работу с этим объектом (развернуть его, масштабировать, дублировать, применить фильтр и др.), необходимо обозначить его границы, то есть создать выделенную область, в которой мы как бы изолируем необходимые нам точки (объект), оставшиеся же пикселы будут восприниматься программой как фон, ограниченный от редактирования.
Но что же делать, если надо отредактировать поочередно группу объектов. Ответ напрашивается сам собой: выделять их по порядку и производить необходимые манипуляции. Но проблема возникает в тот момент, когда выделенная ранее область может понадобиться вновь, а выделения зачастую могут иметь довольно сложные формы. Допустим, вы целый час провозились с выделением волос, применили кучу фильтров, настроек и, наконец, перешли к следующей своей задаче. Но вдруг вам вновь понадобится выделенная область, и что же делать, работать сначала? Именно для таких случаев и были придуманы маски, которых одновременно может храниться большое количество и которые при своей активизации превращаются в область выделения. Их можно складывать, находить их пересечения и производить ряд других манипуляций. В общем, маски вещь довольно интересная и, несмотря на то, что сперва кажутся довольно запутанными, легки в освоении.
До сих пор мы встречались лишь с контурным выделением, но порой нам необходимо создать плавный переход от одного объекта к другому либо контурное выделение, но весьма сложной формы. Со всем этим поможет справиться режим быстрой маски. Это наиболее простой и удобный способ определить необходимую группу точек. Прежде чем войти в этот режим, как правило, создается приблизительная область выделения, при помощи стандартного набора инструментов, предназначенных для этих целей в "PhotoShop" (различные виды лассо, волшебная палочка, простые области выделения). Затем, перейдя в режим быстрого маскирования, вы имеете возможность сосредоточиться на уточнении выделения. Хочется отметить, что изначальное определение области выделения необязательно, но это поможет вам в работе, пока вы окончательно не освоитесь с новыми альфа-каналами.
В режим быстрой маски вы можете перейти, выбрав его на панели инструментов либо путем нажатия клавиши "Q". Если вы последовали моему совету и изначально выделили какую-либо область, то изменения увидите сразу после перехода в режим быстрой маски. Выделенная область представляется в виде пленки светло-красного цвета. Красный цвет пленки установлен в программе по умолчанию. Однако если в вашем изображении довольно много цветов красного оттенка, то создание маски будет несколько затруднено. Я советую открыть панель каналов, в конце вы увидите временный канал, называемый "быстрой маской". Щелкните по нему два раза левой клавишей мыши либо в дополнительном меню выберите "параметры быстрой маски". Перед вами откроется таблица, в которой вы сможете выбрать цвет маскировки, а также ее прозрачность.
Вы наверняка обратили внимание, что при переходе в режим быстрой маски контур выделения исчез. На самом дели он временно прекратил свое существование, так как все производимые операции будут относиться непосредственно к самой маске и не затронут изображение.
При переходе в стандартный режим либо при повторном нажатии клавиши "Q" контур появится вновь.
Для того чтобы удалить часть выделенной области, вам надо добавить пикселы белого цвета, чтобы добавить — красного. Эту операцию вы можете выполнять при помощи любого инструмента PhotoShop, в том числе и таких инструментов, как кисточка, аэрограф, ластик. При раскраске полутонами вы добавляете растушеванные выделенные области. Как видно, режим быстрой маски позволяет растушевывать одни контуры, в то время как другие остаются четкими. К тому же вы можете многократно изменять контуры выделения, видя свое первоначальное изображение, что имеет немаловажное значение.
Но, создавая маски, не следует забывать о столь замечательном инструменте, как градиент. Он позволяет добиться наиболее плавного перехода от выделенной области к частично выделенной и, наконец, к не выделенной.
На основе этого замечательного свойства я и предлагаю создать новое изображение, которое мы "слепим" из двух других. Итак, возьмите две фотографии или два рисунка, впрочем, выбор предоставляю вам самим. Я взяла фотографию большого города и прибрежного пейзажа с пальмами.
Возьмите первое изображение и выделите все. Это можно сделать при помощи сочетания клавиш "Ctrl+A", либо "выделить -> все". Затем скопируйте в буфер "правка -> копировать", либо "Ctrl+C".
Теперь перейдем ко второму изображению. Перейдите в режим быстрого маскирования, нажав клавишу "Q". Затем при помощи инструмента "линейный градиент" создайте линейный переход от черного к белому, либо вы можете выбрать градиент с переходом от переднего плана к фону. Черный участок представляет область, которую вы хотели выделить. Если при использовании градиента у вас возникнет ощущение присутствия на вашей маске полос, то вы можете добавить немного шума с небольшим значением его величины (порядка 24) и равномерным распределением. Когда вы получили удовлетворяющий вас вариант, то вы можете перейти в обычный режим при помощи повторного нажатия клавиши "Q". Если вы вдруг перепутали выделенную область с невыделенной, то вам вовсе не обязательно возвращаться в режим быстрого маскирования, а лишь достаточно инвертировать ваше выделение, нажав клавиши "Ctrl+Shift+I", либо "выделить -> инвертировать".
Когда вы определились с выделенной областью, осталось выполнить следующее "правка — > вставить в", либо "Ctrl+Shift+ V". Ну как вам результат, впечатляет? Да, кстати, если у вас монитор поддерживает разрешение хотя бы 800*600, то вам вовсе не обязательно копировать первое изображение в буфер, а затем вставлять. Вы можете просто перетащить выделенное изображение при зажатой клавише "Ctrl". (Рекомендуемое разрешение при работе с графическими редакторами 1024*768).
Я думаю, вы убедились, что режим быстрой маски позволяет создавать эффекты недоступные при работе с обычными выделениями. И не забывайте, что у вас есть не только линейный градиент, но и радиальный, ромбический, угловой, отраженный, а также всевозможные фильтры и другие автоматизированные спецэффекты.
Если же ваша временная маска может вам еще понадобиться, то не стоит выходить из ее режима, предварительно не сохранив ее, а программа позволяет вам это сделать. Для этого достаточно в палитре каналов перетащить "Быструю маску " на значок, символизирующий новый канал.
Все выше сказанное относилось к быстрой маске, но существует еще и простая. Она представляет собой выделение, сохраненное в независимом канале, который можно также редактировать, как и "быструю маску". Как же создать такой новый (альфа) канал или маску? А очень просто! Вам необходимо преобразовать выделенную область в канал маски. Для этого вы можете произвести следующие действия: "выделить 
-> сохранить выделенную область", либо вы можете щелкнуть правой клавишей мыши в окне изображения и выбрать "Сохранить выделение", это позволит преобразовать вашу выделенную область в новый канал. Если у вас есть какой-то старый канал, который вам больше не понадобится и вы хотели бы его заменить, то вам нужно выбрать имя его в раскрывающемся меню "каналы". Но есть еще и третий способ преобразовать выделение в канал. Для этого достаточно щелкнуть мышью на ярлычке создания канала (не путать с новым каналом) — и PhotoShop автоматически создаст новый канал, преобразует область выделения в маску и поместит ее в этот канал. Проверить, как выглядит маска, вы можете, щелкнув на соответствующем ярлычке в палитре каналов. И не забывайте, что белым цветом представлена выделенная область, черным — невыделенная, а полутонами — частичное выделение. Если вам надо преобразовать канал в область выделения, то вам необходимо нажать сочетание клавиш "Ctrl+Alt+ номер преобразуемого канала", либо щелкнуть мышью на пиктограмме преобразования маски в выделение в нижней части палитры каналов.
Если вам необходимо добавить канал к какой-либо области выделения, то щелкните на имени соответствующего канала, зажав при этом клавиши "Ctrl+Shift". Если же вам нужно пересечение, то зажатыми должны быть клавиши "Ctrl+Shift+Alt".
И еще один нюанс. Если вам понадобится отредактировать контур выделения внутри канала маски, то щелкните на кнопке режима быстрого маскирования. Это может показаться несколько странным, но вы действительно можете перейти в режим быстрого маскирования, даже если работаете в канале маски. Но только цвет маски и цвет быстрой маски должны непременно отличаться.
Маски, как никакой другой инструмент в PhotoShop, демонстрирует сверхвысокий профессиональный уровень и фантазию создателей этой программы. Действительно, с помощью масок редактирование многослойных и сложных изображений превращается в легкое и занимательное дело. Результаты же просто фантастичны по своему качеству и красоте (хотя, разумеется, все зависит и от вас). Стоит сказать, что подавляющее большинство сложных рекламных коллажей, которые я видела, созданы с непосредственным участием маскирования. И это не удивительно, ведь вы видели, какого интересного эффекта вы смогли добиться, используя лишь две фотографии и один градиентный переход. Но ведь возможности этим не ограничиваются, так как у вас есть еще множество фильтров, спецэффектов, экшенов.
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	Непременной частью любого живописного произведения является рамка. Она подчеркивает оригинальность, своеобразие работы и только ей присущие особенности. Именно поэтому подобрать рамку для картины может далеко не каждый человек, и занимаются этим в основном профессионалы. Ведь выбор обрамления произведений такой большой, что невозможно перечислить даже все основные параметры. Однако основополагающими являются размер, структура, рельефность и цвет этого изделия. Также рассматриваются особенности интерьера, в который данное произведение будет помещено. Ну и, конечно же, никогда не стоит забывать о личном восприятии, любви к тем либо иным материалам и цветам, если творение предназначается в частное владение.
С начала ХХ века большое распространение получили новые рамки, которые отражали господствующий стиль в искусстве. Это и импрессионистские, и сюрреалистичные, и рамки в стиле модерн. Всплыли давно забытые методы, практиковавшиеся старыми мастерами (плетение из соломки). Не остались без внимания и рисованные рамки, в основном применяющиеся при создании фресок. 
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Именно о таких рисованных рамках и пойдет сегодня речь. Компьютерная графика предоставляет грандиозные возможности в этой области. Вы можете подбирать текстуру, менять цвет уже после создания готового варианта, что никак не возможно в реальной жизни. Ну и наконец, оформление в компьютерной графике играет также не последнюю роль. Не обойтись без него ни при оформлении работ, предназначенных в издательское дело, ни при Web-дизайне.
Процесс создания рамки в PhotoShop превращается в легкое и увлекательное занятие. Значительно облегчается процесс создания обрамления при помощи различных дополнительных плагинов, например, набора фильтров Photo Tools либо Photo Frame.
Я хочу рассказать о нескольких простых способах создания рамок в PhotoShop. Вы можете бесконечно долго развивать предложенные вам методы, так как пространства для фантазии останется у вас очень много.

Итак, рамка 1. 
Начнем мы с самой простой рамки. Откройте изображение, к которому будет предназначаться созданное вами обрамление. Перейдите в палитру каналов и создайте новый. Вы можете это сделать, щелкнув по эмблеме нового канала левой клавишей мыши. В нем необходимо создать прямоугольное выделение.
Инвертируйте ваше выделение при помощи клавиш Ctrl+Shift+I, либо "Выделить -> Инвертариовать". Залейте белым цветом полученную область. Не стоит забывать о том, что белый цвет символизирует ту часть изображения, с которой в дальнейшем будет продолжаться работа, то есть после преобразования данного слоя в выделение именно эта область окажется выделенной. После того, как вы воспользовались инструментом "заливка", выделение можно снять, оно больше не понадобится. Это можно сделать, нажав клавиши Ctrl+D, либо "Выделение -> Ничего не выделено".
Теперь воспользуйтесь стандартным фильтром PhotoShop "Штрихи. Кисти", "Фильтр -> Штрихи. Кисти -> Распыленные штрихи". На рамке, изображенной на рисунке, использовались следующее настройки: Наклон штриха — Правый диагональный, Длина штриха — 18, Радиус разброса 23.
Перейдите в цветовой режим RGB, нажав сочетание клавиш Ctrl+~, либо щелкнув в окошечке рядом с иконкой канала левой клавишею мыши. Все выполняемые ранее операции относились к новому, созданному каналу, другое название которого — маска. Теперь мы перейдем к непосредственному созданию рамки. Итак, загрузите созданный канал в виде выделения. Это можно сделать, щелкнув левой клавишей мыши по пунктирному кругу внизу палитры каналов, либо щелкнуть непосредственно по самому каналу при нажатой клавише Ctrl. Вы увидите тут же появившуюся выделенную область. Если же вы все таки перепутали выделенную область с невыделенной при создании канала или маски, то не огорчайтесь. А просто инвертируйте выделение. Нажмите клавиши Ctrl+Shift+I, либо "Выделение -> Инвертировать".
Ну что ж, теперь вы можете залить полученную вами область при помощи инструмента "Заливка" любого градиента, либо заполнить ее текстурой.
Вот и все готово. Как вы сами смогли убедиться, процесс создания легкий и быстрый, а результат довольно интересный.
Все последующие рамки будут создаваться примерно по тому же принципу, что и первая, однако, с привнесением в них дополнительных настроек.

Рамка 2.
Для начала повторите те же действия, что и при создании первой рамки, а именно: загрузите изображение, для которого предназначается рамка, создайте новый канал, выделите прямоугольную область, инвертируйте выделение, залейте полученную область белым цветом, снимите выделение.
Хочется отметить, что все выполняемые вами действия можно выполнять и в режиме быстрой маски, если вы не собираетесь использовать вашу рамку вторично.
После того как вы проделали все вышеописанное, воспользуйтесь фильтром "Вихрь". "Фильтр -> Искажение -> Вихрь". Я использовала угол равный 392, однако вы можете выбрать любое другое значение.
Далее осталось дело за малым, однако именно на этом этапе вам предстоит повозиться для того, чтобы найти необходимые вам параметры. Их значения пояснять не имеет смысла, так как это тот случай, в котором пока не попробуешь сам, не поймешь. Вам необходимо применить фильтр "Цвето-полутон". Как это сделать? Очень просто: "Фильтр -> Оформление -> Цвето-полутон". Не пугайтесь большого количества настроек. После нескольких экспериментов все станет понятно. Я при создании представленной вам рамки использовала следующие настройки:
Максимальный радиус — 8 пикселов, Канал 1 — 108, Канал 2 — 165, Канал 3 — 90, Канал 4 — 45.
После применения этого фильтра перейдите в цветовой режим RGB и выполните операции аналогичные операциям, приведенным в первом примере. Вам необходимо загрузить канал как выделение, залить его понравившейся вам текстурой, либо цветом. Вот и все, и ничуть не сложнее первого примера и не уступает в эффектности.

Рамка 3.
Начало создания аналогично первым двум. Загрузите необходимый файл, перейдите в палитру каналов, создайте новый.
На следующем этапе я изменила прямоугольное выделение на круглое. Я считаю, что рамка может иметь любую форму, и чем оригинальнее она будет, тем лучше и интереснее. Здесь же я привожу примеры с простыми геометрическими фигурами, так как на них наиболее ярко заметны эффекты применяемых фильтров. Итак, выделив круглую область, я инвертировала выделение Ctrl+Shift+I, либо "Выделение -> Инвертировать", и полученную область залила белым непрозрачным цветом. Кстати, не забывайте, что при работе с новым каналом, который затем будет преобразован в выделение, ни в коем случае не стоит отказываться от использования серых оттенков, которые символизируют частично выделенные области. Чем темнее цвет, тем менее прозрачной станет область при переходе к выделению и тем менее подвержена воздействию она будет. Сейчас снимите выделение Ctrl+D, либо "Выделение -> Ничего не выделено".
Теперь я предлагаю воспользоваться фильтром "Мозаика". "Фильтр -> Текстура -> Мозаика". Тут тоже имеется довольно большой простор для экспериментирования. На рамке, представленной вашему вниманию, были использованы следующие опции: Размер — 23, Ширина — 12, Легкий осадок — 3.
После применения данного фильтра перейдите в цветовой режим RGB (Ctrl+~, либо щелчок мыши рядом с иконкой данного канала), загрузите созданный вами канал в выделение и залейте полученную область по своему вкусу.
На этом раздел с рамками я хотела бы завершить. Я надеюсь, что вы поняли, насколько процесс создания рамок прост. Но несмотря на свою простоту, рамки позволяют значительно улучшить внешний вид фотографии либо созданного вами изображения. Даже простенький рисунок при должном оформлении принимает совсем другой вид. А при работе в PhotoShop создавать рамки легко и довольно быстро, а главное тут ваша фантазия может найти выход и преобразоваться в превосходное обрамление ваших работ.
Хотелось бы отметить еще одну возможность создания рамки. Она чем-то похожа на предыдущие, но в ней не используются фильтры.
Итак, приступим.

Рамка 4.
Откройте изображение, которое стоит поместить в рамку. Следует отметить то, что рамкой будет служить преобразованная внешняя часть изображения, поэтому если вверху, внизу, либо где-то с краю находятся важные детали, которые нельзя терять, то такая рамка не подойдет. В отличие от предыдущих, описанных вариантов, которые можно создавать на отдельном файле, а затем помещать в них изображения, с этой рамкой такие вариации не возможны. Если эти детали не столь важны, но все же должны быть видны, вы сможете создать прозрачное обрамление с плавным переходом от менее прозрачных краев к совсем прозрачному центру, либо наоборот, в общем все эти вопросы вам предстоит решать самостоятельно.
На следующем этапе я создала круглую выделенную область, которую преобразовала в новый канал. Если вам удобнее работать сразу с новым каналом, то вы можете сперва создать его, а затем уже создавать выделение. Инвертировав его, я залила получившуюся область белым цветом, точно так же, как и при создании предыдущих рамок. Не забудьте снять выделение перед тем, как переходить к следующему этапу.
Так как я хотела добиться равномерного плавного перехода от области, подверженной воздействию, к области, которая этому же воздействию будет неподвластна, я воспользовалась фильтром размытие. Я выполнила следующие операции: Фильтр -> Размытие -> Размытие по Гауссу. Причем применила я этот фильтр дважды. Один раз с величиной гаусс-размытия равной 9,4, а второй раз — 21. Этап подготовки базы для создания рамки в моем случае подошел к концу, однако вы на этом можете не останавливаться. После того как вы добьетесь желаемого результата, можете переходить к следующему этапу.
Вернитесь в режим цветовой модели RGB и загрузите в качестве выделения созданный вами канал. Да, вы, наверно, заметили, что я все время говорю про цветовую модель RGB, однако если вы привыкли работать с другими моделями, то можете спокойно продолжать создавать ваши изображения в режимах Lab или CMYK.
После того как вы перешли в режим выбранной вами цветовой модели и загрузили маску, начинается второй этап творчества. Далее я опишу процесс создания рамки, представленной вашему вниманию, но не стоит забывать, что к каждому отдельному изображению нужен свой персональный подход, и то, что хорошо смотрится в данном случае, может быть просто нелепым в другом.
Далее я выполнила следующее: нажав клавиши Ctrl+U, либо "Изображение -> Настройка -> Цвет. Насыщение", я установила флажок в графе цвет и настройки, приведенные ниже: Тон — 236, Насыщенность — 53, Легкость — -10.
"Изображение -> Настройка -> Уровни", либо сочетание клавиш Ctrl+L. Тут я передвинула рычажок немного вправо, чтобы увеличить различие между тоном рамки и самого изображения.
"Изображение -> Настройка -> Кривые", либо Ctrl+M. Рисунок кривых, которые я применяла, я приводить не буду, так как это не имеет никакого смысла. При малейшем изменении исходного цвета либо тона итог при данных кривых окажется совсем другой, а так как вы будете использовать изображения, не имеющие ничего общего с приводимым примером, то и кривые, используемые мной, вам не пригодятся. Следовательно, тут вам придется немного повозиться и найти вариант подходящий для вашего случая, но то, что получилось у меня в итоге, вы можете увидеть на приведенной фотографии.
Я описала процесс создания нескольких рамок и два абсолютно разных подхода к этому вопросу. Однако осталось еще немало возможностей и очень много места для экспериментов. Обилие фильтров для PhotoShop, различных дополнительных настроек, а также вашей фантазии позволят вам создавать много интересных рамок и делать еще лучше созданные вами изображения. И не стоит забывать о том, что очень важно то, как вы преподнесете ваше творение, а рамка как нельзя лучше поможет подчеркнуть его сильные стороны и скорректировать некоторые недостатки.
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	В этой статье я опять частично отойду от темы серии, описав работу с текстом в PhotoShop 6.0. Дело в том, что в письмах читатели просят обратить на это повышенное внимание. И поэтому, несмотря на то, что данная серия статей посвящена неявным эффектам в PhotoShop, я пойду на поводу просьб читателей и опишу работу с текстом.
Также в этой статье вы найдете описание интересной методики смены времени суток. Могу вполне смело говорить о том, что больше об этом не написано нигде, а этот эффект описан исключительно исходя из личного опыта решения одной задачи.

Третья часть статьи будет посвящена описанию одного из лучших существующих на данный день наборов дополнительных плагинов - KPT 6.0. В прошлой статье я описала KPT 5.0, и это станет вполне логическим продолжением затронутой темы.

Так что, в определенном смысле, эта статья станет уникальной в рамках данной серии - в ней будет по одному примеру всех затрагиваемых тем: явная работа в программе, неявная работа и дополнительные эффекты.

Работа с текстом в PhotoShop 6.0

В более ранних версиях работа с текстом была самым слабым местом PhotoShop. Именно это заставляло устанавливать дополнительные программы, цель которых была только одна - исправить этот недостаток лучшего графического редактора. Однако, в шестой версии произошли революционные изменения, создание текста стало походить на простое написание на изображении (для тех, кто не работал с предыдущими версиями - раньше для этого открывалось специальное окно, что было весьма неудобно). Также, наконец, создатели PhotoShop решили глобальную проблему текста по кривой линии. Вот на такой оптимистичной ноте мы и приступим к изучению возможностей PhotoShop в создании текста.

Для написания текста используется специальный инструмент "Text", горячая клавиша "T". Однако, в большинстве работа с надписями состоит в не их написании непосредственно, а в настройке уже написанного. Поэтому сразу обратите внимание на вид палитры (или строки) параметров после нажатия "T" (рис.1)
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Исходя из этого рисунка будет строиться дальнейшее описание.

1. Обычный текст по умолчанию. Пишем тем цветом, который у нас основной или цвет переднего плана (Foreground Color).

1. Писать выделением. Применяется для создания, к примеру, эффекта выдавленных букв на фотографии. Это очень просто, настолько просто, что мы даже не стали выносить в отдельный пример. Прежде всего, пишете любую надпись выделением. Затем копируем содержимое выделенной области (Ctrl+C) и вставляем немедля же. На вид ничего не изменилось, но теперь мы можем применить эффекты слоя. Для этого жмем: Layer->Layer Style->Bevel and Emboss (Слой->Стиль слоя->Рельеф и объем). Вот и все! Для незнающего человека фантастический эффект, у вас же заняло несколько секунд.

2. Горизонтальное направление текста.

3. Вертикальное направление текста.

4. В этом меню вы выбираете, какой именно шрифт использовать. Если вы хотите серьезно работать в PhotoShop, то только теми шрифтами, что ставятся вместе с системой, вам не ограничиться. Да, существуют шрифты, состоящие не только из букв, но и из символов - всяких самолетиков, человечков и так далее.

5. С этим, я уверена, проблем не будет никому. Тут вы выбираете, каким стилем писать текст - полужирным, курсивным подчеркнутым или другим. Все интуитивно понятно, поэтому не будем останавливаться.

6. Вы здесь выбираете размер шрифта. Возможны самые разные единицы измерений, как их менять, написано в главе "Настраиваем PhotoShop". В том случае, если размеры, которые есть, вам не подходят, можно использовать "Free Transform".

7. Антиалиазинг. В общем, направление действия этого параметра - избавить от некачественного вида маленьких шрифтов (раньше эта проблема была). Тут вы указываете способ избавления от неровности шрифтов.

8. Писать левосторонним абзацем. То есть, курсор будет уходить с каждой буквой в правую сторону от начальной точки.

9. Писать центральным абзацем. Наиболее часто применяемая форма.

10. Писать левым абзацем.

11. Выбор цвета текста. По умолчанию стоит тот, который у вас определен основным цветом или цветом переднего плана (Foreground Color).

12. А вот на этом мы остановимся подробно, так как это революционное нововведение PhotoShop 6.0 - искривление текста.

Если вы выберете любой из этих вариантов, то у вас станут доступными следующие параметры:

- Bend (Закругление) - с какой степенью производить указанный эффект.

- Horizontal Distortion (Горизонтальное искривление) - производит эффект большего применения в горизонтальном направлении.

- Vertical Distort (Вертикальное искривление) - производит эффект большего применения в вертикальном направлении.
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Результаты применения всех модификаторов вы можете видеть на иллюстрации.

Этот инструмент (Warp Text) явился одним из лучших нововведений шестой версии. Раньше нарисовать, к примеру, эмблему с текстом по окружности было целой проблемой - приходилось каждую буковку ставить по отдельности. Теперь это почти не займет времени и усилий.

Ну, с Warp Text закончим и пойдем дальше.

13. Включить палитры. В результате нажатия у вас появятся две новые палитры - Character (Характеристики) и Paragraph (Параграф).

Мы рассматривать их подробно не будем, так как они во многом повторяют палитру параметров, но несколько совершенствуют многие вопросы. Если вам интересно, то просто пощелкайте по разным параметрам и посмотрите эффект - все понятно интуитивно. В основном эти палитры используют те, кому необходимо много настроек текста.

Пару месяцев назад я уже описывала, как добиться возможности писать в программе кириллицей. Но все равно приходят письма с просьбой написать, как это сделать. Поэтому повторю это еще раз, так как далеко не все имеют возможность найти ту статью и прочитать. Мне, как говорится, не жалко, абы читатели были сыты и довольны:).

Способ первый - терапевтический

1. Запустите редактор реестра (например, в директории Windows запустите Regedit.exe или в основном меню выберите "выполнить" и наберите "regedit");

2. Откройте HKEY_LOCAL_ MACHINESYSTEMCurrentControlSetControlNlsCodePage;

3. Теперь измените значение 1252:

Для WindowsNT "C_1251.NLS", для Windows95/98 "cp_1251.nls"

4. И обязательно перезагрузите компьютер. Если вы все сделали правильно, то должно заработать.

Способ второй - хирургический

Дело в том, что шрифты, поставляемые вместе с Windows, сами по природе своей не русские. Поэтому можно купить диск со шрифтами и переустановить в системе их все, используя "Шрифты" из Панели управления.

Делаем из дня ночь

В этом примере будет описано решение очень интересной задачи - смены времени суток. Мы постараемся из солнечного дня сделать звездную ночь. Конечно, определить, что это не фотография ночного города, можно будет без особых проблем, однако результат будет достаточно реалистичным и оригинальным.

Наша работа основана на том, что ночью все объекты видны только в градациях серого, естественно, если нет искусственного освещения. То есть, сделать из дня ночь достаточно просто, но вот из ночи день - задача абсолютно неподъемная.

Прежде всего, подберите фотографию. Лучше, если на фоне неба не будет деревьев, но и это тоже не преграда. Ориентируйтесь по иллюстрации к этой статье.

Сперва необходимо отделить небо от всего остального. В том случае, если у вас геометрически сложные объекты, вроде деревьев, заслоняют горизонт, придется воспользоваться способом выделения через каналы. Это очень просто и не раз уже было описано в этой серии.

Нам же такой способ сейчас не требуется. На фоне неба на данной фотографии только купола храма, выделить которые не представляет особой проблемы. Для этого лучше всего использовать Magnetic Marquee Tool (Магнитное лассо) или Прямоугольное лассо. Не забудьте о том, что если вы используете инструменты выделения при нажатой клавише Alt, то выделенная область отнимается от имеющейся, а при использовании с зажатой клавишей Shift, наоборот, добавляется. Не забывайте выделять и такие места, как крупные просветы между ветками и тому подобное.

После того, как вы качественно выделили небо, можно приступать непосредственно к созданию эффекта.

Инвертируйте выделение: (Ctrl+I) либо Select->Invert (Выделение->Перевернуть). В результате будет выделено все, кроме неба. 
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Избавимся от цветов в изображении. Но для этого нельзя использовать смену цветового режима, так как итоговое изображение у нас цветное. Для выполнения данной задачи идеально подходит команда Desaturate: Image->Adjust->Desaturate (Изображение->Настройка->Убрать цвет). Как итог, вся нижняя часть фотографии обесцветиться, что нам и надо.

Однако, яркость и освещенность фотографии отнюдь не ночные. Исправим это при помощи Levels: Image->Adjust->Levels (Изображение->Настройка->Уровни) или сочетания клавиш "Ctrl+L". Необходимые настройки вам придется подобрать самим, так как наши годятся только для данной фотографии, которой воспользоваться у вас явно не будет возможностей.

Впрочем, для решения этой задачи не с меньшим успехом можно использовать Brightness/ Contrast. Все равно, настраивать приходится исключительно на глаз, а с этим инструментом большинству пользователей работать значительно удобней из-за меньшего количества настроек по сравнению с Levels.

Земля почти сделана. Однако, ночью очень четких контуров не видно, что связано со свойствами человеческого зрения. Это необходимо показать и в нашей работе. Применим фильтр Gaussian Blur: Filter->Blur->Gaussian Blur (Фильтр->Размыть->Размыть по Гауссу). Значение Amount (Величина) выставьте в пределах 1-3.

Теперь займемся непосредственно небом. Инвертируйте выделение (Ctrl+I).

Установите в качестве цвета переднего плана темно-синий, а в качестве фона - черный. Это необходимо нам для применения инструмента Градиент.

Запустите Gradient Tool (Градиент) и убедитесь, что он находится в режиме Foreground to Background. Примените его так, чтобы синий оказался ближе к горизонту, а черный - к верху фотографии. Это необходимо для повышения реалистичности изображения, так как небо ночью почти никогда не бывает одноцветным, горизонт, особенно поздно вечером, темно-синий.

Ну вот, уже очень похоже на ночь. Осталось создать звезды и луну. Начнем с первого.

Опыт показал, что самый быстрый, простой и качественный способ рисовать звезды - это непосредственное их создание при помощи кисти.

Выберите в качестве цвета переднего плана белый или светло-желтый. Выбор зависит только от вашего желания и конкретной ситуации. Обязательно стоит создать новый слой (Shift+Ctrl+N).

Возьмите маленькую кисть с размытыми краями и нарисуйте несколько десятков звезд. Тут есть одно правило - не должно быть никакой симметрии и ближе к горизонту звезд нет вообще (то есть, там выше освещенность, и в реальной жизни в подобных условиях их не видно из-за невысокой яркости).

Затем смените кисть на более крупную и нарисуйте более яркие звезды. Но запомните - там, где начинаются оттенки синего, больших звезд быть не должно, так как там выше освещенность.

Остался последний этап - нарисовать луну. Это очень просто, несмотря на то, что сперва кажется непосильной задачей.

Создайте круглое выделение при помощи Radial Marquee Tool. Не стоит сразу делать его равным по размеру будущей луне, это помешает работе. Создайте его как можно больше.

Примените Feather: Select->Feather (Выделение->Оперение) c величиной, равной 5 пикселям. Это позволит в дальнейшем создать луну с плавным переходом в небо.

В качестве цвета переднего плана (Foreground color) установите темно-желтый, в качестве фона - черный.

Применим фильтр Clouds: Filter->Render->Clouds (Фильтр->Рендер->Облака). Вы получите пятна на будущей луне. Но они выглядят еще недостаточно естесственно. Исправить это можно, увеличив контрастность при помощи Brightness/Contrast: Image->Adjust->Brightness/Contrast (Изображение->Настройка->Яркость/Контраст). Придайте луне необходимый размер и установите ее на необходимую позицию, используя инструмент Free Transform (Свободная трансформация), который можно вызвать при помощи нажатия Ctrl+T. На этом работа закончена. Ничего получилось, не правда ли? Конечно, вы можете пойти и более простым путем в случае, если имеется изображение с ночным небом. Тогда можно перенести его на редактируемую фотографию простым копированием и не рисовать звезды и луну вручную. Но согласитесь, это уже примитивно и неинтересно, а к тому же, подходящего источника для копирования никогда нет под рукой.

KPT 6.0

В прошлой статье был описан набор дополнительных плагинов для PhotoShop KPT 5.0. Однако не стоит считать KPT 6.0 следующей его версией, это идейно совсем другая программа. Если KPT 5.0 имеет своим направлением искажение уже имеющегося на изображении, то эта программа направлена на создание нового. Она куда чаще может быть использована с "чистого листа". Самый крупный недостаток данного набора - большие системные требования. Если у вас слабый компьютер, то придется столкнуться с большими проблемами при работе, особенно, что касается скорости.

Приступим непосредственно к описанию плагинов. Их немного - всего 10, но каждый мог бы быть и отдельной программой, настолько они сложны. Впрочем, некоторые раньше и были отдельными фильтрами, но об этом позднее.

Equalizer. Отличный цветокорректирующий плагин. Своеобразная система, действительно несколько напоминающая эквалайзер, позволяет очень быстро добиваться того же эффекта, на реализацию которого при работе, к примеру, с кривыми ушло бы достаточно много времени. Но и возможности Equalizer значительно ниже, чем у тех же стандартных Curves из PhotoShop. Впрочем, не совсем было бы верно относить этот фильтр к цветокорректирующим. Его результат является смесью этого направления и искажения.

Gel. Раньше этот фильтр был отдельной программой, но теперь его включили в KPT 6.0. Дает возможность рисовать очень своеобразной массой, больше всего напоминающей действительно гель. Выглядит это эффектно и красиво. Хотелось бы отметить удачный интерфейс, благодаря которому освоить Gel не составит никакого труда. Область его использования достаточно широка, от объемных букв и кнопок до текстур. В частности, реалистичная текстура золота рисуется за несколько секунд.

Goo. Этот фильтр должен заинтересовать скорее любителей, чем профессионалов. Делает он примерно то же самое, что и Liquify в PhotoShop 6.0, правда, работать не так удобно. Разумеется, появление последнего PhotoShop убило бы Goo как конкурентный программный продукт, если бы не одно но. Вы можете записывать порядок действий и получить очень смешную анимацию. Goo может стать вашей любимой игрушкой на долгое время и великолепным средством развлечения гостей. Как помнят постоянные читатели, Goo был описан как отдельная программа несколько месяцев назад.

LensFlare. Фильтр, создающий различного рода блики. Широчайшие возможности и высокая реалистичность позволяют рисовать не только блики от камеры, но и звезды, кометы и так далее. Пожалуй, это один из самых лучших фильтров для создания сложных эффектов света из всех мною виденных. Радует наличие большого количества готовых вариантов, большинство из которых очень удачны.

Materializer. Плагин, выполняющий примерно ту же функцию, что и стандартный фильтр PhotoShop Texturizer, только значительно лучше. То есть, он придает изображению вид того или иного материала в зависимости от карты. Спектр возможных к созданию материалов невероятно широк - от стеклянной линзы до кирпичной кладки. Стоит отметить, что научиться пользоваться этим плагином очень непросто. Лучше всего внимательно прочитать поставляемый в комплекте с KPT 6.0 электронный учебник. Но этот вариант годится только в том случае, если вы хорошо знаете английский.

Projector. Полезнейший фильтр с кучей возможностей. Представляет ваше изображение как плоскость в пространстве, которую можно вращать как угодно. Кроме того, можно создать плоскость, уходящую в перспективу (или две). Но это еще не все. Самая приятная вещь состоит в том, что все действия с изображением можно сохранять и анимировать, получив в итоге видео-файл в формате Avi.

Reaction. Фильтр, перерисовывающий ваше изображение большими переплетенными линиями. Идеально подходит, чтобы имитировать стиль импрессионизм. Но возможны и другие варианты, перечислять которые невозможно из-за огромного их количества. При помощи Reaction также хорошо рисуется мозг, извините за такой откровенно анатомический пример.

SceneBuilder. Плагин, вносящий в PhotoShop элементы трехмерной графики. Сам он, по сути, и является примитивным 3D редактором. В обработке объектов вы сильно ограничены, так как не можете создавать свои, а приходится пользоваться готовыми примитивами. Но из них можно составлять очень интересные конструкции. Также можно найти дополнительные объекты к SceneBuilder, а среди них есть множество очень полезных, к примеру, фрукты, люди и так далее.

SkyEffects. Раньше это была отдельная программа "Four Seasons". Но компания Metacreations купила ее у прежнего владельца и включила в качестве плагина в KPT 6.0. Этот плагин позволяет создавать различного рода атмосферные явления в виде простого пейзажа. В принципе, делает это достаточно хорошо, но вот интерфейс программы оставляет желать лучшего. Этот плагин также был описан в одной из прошлых статей.

Turbulence. Самый впечатляющий фильтр в наборе. Создает впечатление, как будто ваше изображение жидкое и вы можете пустить по нему волну. К тому же это можно анимировать и записать в видео-файл. Выглядит невероятно красиво, никакая статичная иллюстрация этого не передаст.

На этом данная статья закончена. Если у вас есть какие-либо вопросы, то не стесняясь пишите мне. Я всегда с удовольствием отвечаю на все приходящие письма. Можете посылать свои находки в области работы в PhotoShop, они обязательно увидят свет в рамках серии и вы будете упомянуты как их автор.
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	Пожалуй, в мире создано не так много программ, которые стали бы не только культовыми среди пользователей и определяющими в своем виде деятельности, но и являлись бы стандартом этой деятельности. Среди таких программ Word из текстовых редакторов, AutoCad из проектировщиков, 3D Studio Max из редакторов трехмерной графики и, несомненно, Adobe Photoshop из программ для редактирования двумерной растровой графики. Популярность этой программы среди профессиональных художников и дизайнеров просто не имеет аналогов. Практически 100 процентов мастеров, работающих с компьютерной графикой, (по данным американского журнала для дизайнеров "Imagine") используют ее в качестве средства обработки растровых изображений. Photoshop также одна из наиболее любимых программ непрофессионалов (правда, в цивилизованном мире это не столь ярко выражено, как у нас. Причина — цена). И это все вполне оправдано. Разработчики действительно создали мощный инструмент, который в умелых руках поистине способен творить чудеса.
С популярностью Photoshop связана особенность этой и последующих статей. Я думаю, не стоит на пальцах объяснять элементарные вещи. Этот пакет не столь сложен, как 3D Studio Max, к примеру, и каждый может изучить основные навыки, просто прочитав помощь программы. Эти же статьи будут ориентированы на малоизвестные стороны PhotoShop, на создание в нем спецэффектов, на цветокоррекцию и на многое другое, что крайне полезно людям, работающим с этой программой. 

Вообще, задачи PhotoShop можно разделить на две части. Первая наиболее известна и используема (хотя этот мой постулат может быть оспорен людьми, близкими к издательскому делу — им ближе вторая часть функций) — это трансформирующая часть, к которой мы можем отнести фотомонтаж, создание спецэффектов и другие яркие функции, на которые прежде всего обращают внимание новички. Несомненно, эта часть в PhotoShop проработана на славу и никаких нареканий вызвать не может. (Освоивший монтаж в этой программе уже никогда не будет так доверять фотографиям в газетах. У меня есть монтаж, где я стою с известными людьми. И никакого отличия от натуральной фотографии непрофессионал не почувствует). Вторая часть хоть и сложнее и менее впечатляюща, но крайне полезна. Это инструменты цветокоррекции в PhotoShop. Они весьма продуманы, и если вы собрались сделать, к примеру, рекламный буклет для своей фирмы, освоить их придется ради результата.
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Статьи будут построены на основе практики. Вообще я считаю, что компьютерные программы стоит изучать в ходе работы. В каждой статье будет 2-3 примера интересного решения и подробное описание значений всех действий. Если вас что-то интересует, напишите на электронный адрес, и это будет учтено в следующих статьях или отвечу вам лично. Только одна просьба: писать "А я не так это делаю!" не стоит. Решений всегда много, я выбираю то, которое считаю наиболее рациональным, вы же можете иметь другое мнение.
Сразу скажу, что начнем мы с работы над текстом. Почему? Во-первых, это наиболее простая часть того, о чем бы я хотела рассказать, во-вторых — наиболее часто используемая. Начнем с самого (несомненно) часто задаваемого вопроса по программе. Как писать по кругу (либо по любой другой заданной кривой)? Увы, пока разработчики не решили эту проблему. Вроде бы обещали к шестой версии исправиться, но пока решения не очень хорошие. Я лично советую найти программу от Еxtensis — Photographics. Это мощное решение, созданное под PhotoShop и интегрируемое в него в виде фильтра. Там эта проблема решена очень хорошо. Но увы, это не всем доступно по разным причинам, поэтому постараемся хоть как-то восполнить этот пробел стандартными средствами PhotoShop.
Этот способ не самый малозатратный по времени, но очень простой по технике. Учитывая то, что чаще всего надпись по кругу приходится применять при создании эмблем, то он оправдывает себя только тем, что надписи, как правило, небольшие.
Итак, приступим к созданию. Создадим новый файл произвольных размеров. Хочется обратить ваше внимание на то, что видимый размер на мониторе и реальный размер — это две большие разницы даже тогда, когда в окне размер картинки обозначен как стопроцентный. Причина тому такова: монитор отображает одну точку изображения на одну точку монитора. А тут и зарыта собака. Файл ваш может иметь разное разрешение и, следовательно, внешне выглядеть разных размеров. Вам придется не верить своим глазам, а смотреть на цифры. Затем необходимо создать область выделения круглой формы (используя инструмент "Эллиптическое выделение", имеющий горячую клавишу "M"), поставить в меню "Параметры" фиксированый кооффициент 1/1 и залить ее любым цветом. Далее нажатием клавиш "Ctrl+D" либо двойным щелчком левой клавиши мыши удалим выделение (так как в PhotoShop выделение, как, впрочем, и почти везде, играет роль ограничения области редактирования). Заметим, что другого способа делать примитивные фигуры в PhotoShop нет, прежде всего по той причине, что это программа для редакции исключительно растровой графики. Но если вам часто нужны готовые геометрические фигуры, воспользуйтесь Adob Illustrator, который хорошо интегрирован с PhotoShop, или, для экономии места на диске, все тем же PhotoGraphics от Extensis. Затем, используя инструмент "текст", напишите любое слово. В нашем случае это слово "PhotoShop". Если вы неправильно указали размер шрифта и буквы у вас больше либо меньше намеченого, воспользуйтесь трансформацией изображения (сочетание клавиш Ctrl + T). Это очень удобный инструмент. Щелкните правой клавишей внутри области трансформации — и вы сможете выбрать режим. Описывать их сейчас не будем, они интуитивно понятны и их вполне можно изучить методом "научного тыка".
В PhotoShop очень важное место занимает работа со слоями. Если вы откроете панельку "Слои", то увидите, что сейчас их у нас два. Первый это фон с кругом, второй — текст. Мы практически ничего не сделаем, если не отрисуем его. Это связано с тем, что для большинства операций нам нужен растровый (то есть описанный по точкам) объект, каковым шрифт не является. Поэтому найдем на слое текста букву T и, щелкнув правой клавишей, выберем "Рендеринг слоя". Теперь можно приступать к нашей основной работе. Возьмем инструмент "прямоугольное выделение" и выделим букву "P". В результате вы должны получить что-то вроде того, что изображено у нас на иллюстрации 1.
Затем зажмите Ctrl+Shift и передвиньте букву немного повыше, к кромке круга. Посмотрите, как выделение обхватило букву. Теперь перейдите в режим трансформации и начните поворачивать букву. Обратите внимание на точку в центре. Это есть то место, вокруг которого осуществляется вращение. Двигайте букву в необходимом направлении до получения удовлетворяющего вас результата. Положительно то, что работаете вы в одном слое. Это значительно удобнее, чем вырезать и вставлять буквы путем использования команд из меню "Редактировать": Вырезать и вставить ("Ctrl+X", "Ctrl+V") соответственно. Установите оставшиеся буквы по примеру первой. Кажется, готово.
Сразу скажу, что часто задают вопрос, почему не работает русский шрифт в PhotoShop. Причина тому — шрифты, следовательно и самое легкое лекарство — заменить в системе шрифты на русские, которые лежат практически на всех дисках с софтом.
Пройдя этот самый легкий этап, попробуем создать что-либо более сложное и более красивое. Так как мне хотелось бы заинтересовать и начинающих работать в PhotoShop, и уже имеющих определенные навыки работы с этой программой, то я буду совмещать в своих статьях описания простых эффектов с описаниями более сложных и более красочных возможностей. И первый такой эффект — надпись, сделанная кровью. 

Для начала создайте заготовку произвольного размера. Убедившись, что изображение находится в нужном режиме, а именно в RGB, приступим к работе. Залейте рабочую область черным цветом и напишите текст. Мы будем работать со словом "adobe". Если вы с первого раза не смогли указать нужный размер шрифта, то не огорчайтесь, а лучше обратитесь к началу этой статьи, где рассказывается о редактировании размера и наклона текста. Написав текст белым цветом, передвинув его ближе к верху, так как нам понадобится место внизу для работы, преступим к следующему этапу. Открываем панель с описанием слоев и, так же как и в первом случае, переводим наш текст в растровое изображение (щелкаем правой клавишей мыши по букве "T" и выбираем рендеринг слоя). Затем склеиваем наши слои. Я предпочитаю работать с клавиатурой, поэтому предлагаю выполнить эту операцию, нажав клавиши "Ctrl+E", однако вы можете это сделать и более привычным для некоторых способом: указать мышью в строке меню на "слой" и затем выбрать "слияние вниз".
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Вот первый этап подготовки закончен, и мы переходим к следующему, к созданию самого эффекта.
Поверните свое изображение на 90 градусов по часовой стрелке (изображение -> вращать холст->90 гр. ч. с.). Затем воспользуйтесь несколько раз фильтром ветер (фильтр -> стиль ->ветер ->слева). Для повторного применения фильтра вовсе на обязательно выполнять все эти операции, достаточно лишь нажать необходимое количество раз клавиши "Ctrl+F". Я повторила это действие 5 раз, но в другом случае это количество может колебаться в различные стороны. Затем переворачиваем наше изображение в первоначальное положение (изображение-> вращать холст -> 90 гр. пр. ч. с.)
На следующем этапе воспользуемся фильтром "штамп" (фильтр -> наброс -> штамп). Я рекомендую светл/темн баланс установить на значение приблизительно равное 5-6 в зависимости от размеров и формы вашего изображения.
Теперь осталось дело за малым — придать надписи действительно кровавый цвет. В фотошопе вообще очень богатый инструментарий по работе с цветовой гаммой, и я надеюсь когда-либо описать это более развернуто. Ну а пока просто сделаем, не вникая в суть происходящего. Я предлагаю сделать это следующим образом:
1. Инвертировать изображение (изображение -> настройка -> инвертировать) либо нажать клавиши "Ctrl+I".
2. Выделение -> все, либо клавиши "Ctrl+A".
3. Правка -> копировать, либо "Ctrl+C"
4. Delete
5. Переходим в палитру каналов и создаем новый, щелкая левой клавишью мыши по эмблеме нового канала, помещенной внизу. Вкладываем в него содержимое буфера. Правка -> вставить, либо "Ctrl+V".
6. Щелкаем мышью по иконке канала RGB и переходим опять к работе со слоями.
7. Там, нажав клавиши "Ctrl+Alt+4", мы увидим выделение, которое следует инвертировать при помощи клавиш "Ctrl+Shift+I", либо выделить -> инвертировать.
8. Теперь область нашего выделения можно залить подходящим цветом. Я выбрала красный.
И наконец, осталась самая малость — придать нашей надписи объем и реалистичность. Для этого я предлагаю воспользоваться фильтром "Bas рельеф" (фильтр -> наброс -> Bas рельеф). В моем случае значение "детали" =12, а "мягкость" =5. При выполнении этой операции цвет переднего плана должен соответствовать цвету вашего изображения, а цвет фона — идентичный фону на вашем изображении.
Хочется отметить то, что не стоит останавливаться только на красном цвете и на рекомендуемых значениях и пропорциях используемых фильтров, так как это сильно сократит ваши возможности, а ведь в действительности этот эффект довольно красочный и интересный. Экспериментируйте, находите возможности, цвета, освещенности, яркости, которые будут близки именно вам.
В моих силах объяснить основы работы, описать ряд спецэффектов, показать возможности работы со слоями и каналами, но давным-давно известно, что навыки и интуиция приходит лишь с опытом работы. Работа в мощных графических пакетах имеет такую специфику, что даже сами создатели не способны учесть и сотую часть возможностей своих продуктов. То есть, никто и ничем не ограничивает вас от поисков новых путей, новых эффектов — эксперемент и опыт есть две составляющие успешного творчества.
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